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  MODULE INTRODUCTION  

Course has three Modules. Under this theme we have covered the following 

topics: 

 

Module 1 Introduction to Computer 

 

Module 2 Introduction to MS Word and PowerPoint 

 

Module 3 Introduction to MS Excel 
 

 

 

 

These themes are dealt with through the introduction of students to the 

foundational concepts and practices of effective management. The structure of the 

MODULES includes these skills, along with practical questions and MCQs. The 

MCQs are designed to help you think about the topic of the particular MODULE.

  

We suggest that you complete all the activities in the modules, even those that 

you find relatively easy. This will reinforce your earlier learning. 

We hope you enjoy the MODULES.  

If you have any problems or queries, please contact us: 

School of Management Studies & Research, 
MATS University 
Aarang – Kharora, Highway, Arang, Chhattisgarh 493441 

MATS Centre for Distance and Online Education, MATS University
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MODULE 1 INTRODUCTION TO COMPUTER 

Structure 

Unit 1 Computer - Definition and Meaning 

 Characteristics Of Computers 

  Generations Of Computers 

Unit 2 Types Of Computers 

 Block Diagram of a Computer 

 Memory And Its Types 

 Storage Devices 

 Computer Network 

Unit 3 Search Engine Concept and Working of Search Engine 

 Operating System And Number System 

UNIT 1 COMPUTER - DEFINITION AND MEANING 

An electrical device that manipulates data or information is called a computer, 

and a computer has been programmed to operate based on a specific group of 

instructions. AI runs on the computer, and computers have changed how AGI 

does its work. They are employed for business, education, healthcare, 

entertainment and research. That helps to explain why the computers and 

hardware we use today in our life can run whatever kind of software that 

needed, also can handle most operation using the software and cloud technology 

to perform on demand.  

CHARACTERISTICS OF COMPUTERS 

Computers possess several characteristics that make them essential tools in 

modern society: 

Speed: Computers are capable of executing millions, if not billions, of 

calculations per second, far surpassing human capability. Computers can handle 

vast amounts of data, execute numerous commands simultaneously, and 

complete intricate computations because to their quick processing speeds. The 

processor cores, memory, system architecture, and countless other
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factors determine how fast a computer is. Computational speed is critical to 

productivity and efficiency in scientific research, financial analysis, and 

engineering simulation. 

Accuracy: Computers are only able to conduct operations with a high degree 

of accuracy when performing calculations. They have of data to learn from, 

computers do not produce computational errors as long as they are coded 

accurately unlike humans. They adhere to preprogrammed instructions and 

perform mathematical and logical computations accurately. In certain domains 

like banking, healthcare, space research, etc., any minor computational error 

can have disastrous results, thereby making this domain highly reliant on 

accuracy. 

Automation: Computers can be programmed to carry out tasks automatically 

without constant human intervention. Sounds like a good candidate for 

automation, especially for repetitive tasks like data entry, report generation, or 

the needs of industrial or enterprise systems. Scripts, macros, and artificial 

intelligence enable computers to increase workflow productivity and alleviate 

manual labor. 

Versatile: Computer is one of the most versatile machines and capable of 

doing almost anything. They can be used for word processing, gaming, 

software development, graphic design, and everything else. Different 

applications can be installed and run on computers, allowing them to be 

customized for many different industries and personal uses. Organizations from 

various industries like businesses, educational institutions, hospitals, and 

government organizations make use of computers for different reasons. 

Large volumes of data can be stored on storage computers, allowing users to 

save and access their information easily. Computers come with various storage 

types, ranging from internal hard drives and solid state drives to cloud and 

external storage solutions. Data can be stored in the form of text, images, audio 

and video files. Data is everything and storage solutions are more important for 

data backup, archival purposes, and access to critical information.

Fundamental 
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Connectivity: Through networks and the internet, computers allow for 

communication and connectivity. It allows users to exchange information, 

collaborate on projects, and access global resources immediately. Computer 

networks are essential for the communication of email, video conferencing, 

cloud computing, and social media platforms. Connectivity also works for 

businesses and individuals, increasing productivity and staying updated. 

Multitasking: Computers have the ability to run multiple applications at the 

same time without slowing down. It could browse the web, edit docs, play 

music and run any number of background processes all at once. For the type of 

professionals who need to manage a workflow, multitasking is key it allows 

them to get things done quicker and overall be more efficient. 

Knowledge about computers and their characteristics, types and functions is 

essential for users to work efficiently in different fields. Computers and Excel 

have thus become the new toys, moving from rudimentary data entry to 

advanced calculations. 

GENERATIONS OF COMPUTERS 

Computers have evolved through five generations: 

First Generation (1940-1956): Used Vacuum Tubes and Consumed High 

Power 

First Generation (1940s to 1950s) Computer generations are the steps of the 

development of computer technology. They used vacuum tubes as their primary 

electronic component, which were relatively large, brittle, and inefficient in 

terms of amplifying electrical signals. In early computers, vacuum tubes were 

used to switch and amplify electrical signals. 

First-generation computers were huge and required a lot of power because of 

vacuum tubes. They filled entire rooms, used massive amounts of electricity 

and generated lots of heat. Heating and cooling systems were necessary to avoid 

overheating, and vacuum tubes, if not merely nasty, constantly failed on 

people. These early systems were inherently unreliable and often broke

Introduction to 
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down, preventing operation. Programming at this time was a cumbersome 

process, all done in machine language, strings of binary codes that were hard to 

write, read and debug. Consequently, the field of programming was largely 

reserved for a handful of engineers and computer scientists. Users entered data 

using punch cards, paper tape and a magnetic drum method that could be much 

more time-intensive and laborious. 

Despite their primitive technology, these early devices demonstrated how 

computers would develop in the future to perform calculations and automate 

tasks. Examples of first-generation computers include the UNIVAC (Universal 

Automatic Computer), the first computer ever sold commercially, and the 

ENIAC (Electronic Numerical Integrator and Computer), which was employed 

for military purposes during World War II. At this time these machines were 

typically used by governments and large corporations in things like scientific 

research, military applications, and early business operations. The first wave 

of computers, while primitive by modern needs, is the foundation on which later 

generations of technology were built. The power-hungry and bulky nature of 

these systems pointed to the necessary steps toward efficiency and 

compactness key factors in the development of computers in subsequent 

generations. First-generation computers are a major leap forward in technology 

and began to demonstrate the feasibility of using electronic devices to automate 

calculations and complex task. 

Second Generation (1956-1963): Used Transistors, Making Them Smaller 

and Faster 

Second generation computers appeared in the late 1950s and were using 

transistor technology, which represented a huge step forward from the first-

generation computers. Transistors, in contrast to vacuum tubes, are solid-state 

devices constructed from semiconductor materials, which makes them smaller, 

more efficient, and more reliable. The switch that the transistor made to the 

design of machines was that it could switch and amplify electronic signals, 

enabling the design of machines that were faster, more compact and that used a 

fraction of the energy. Transistors were also significantly smaller than their 

bigger brothers, which resulted in smaller computers too. This was

Fundamental 
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a big departure from the first machines, which filled entire rooms. These 

developments made second-generation computers more convenient for 

business and academic purposes, and a few companies started to produce and 

sell computers. 

With the greater reliability of transistors, second-generation computers were 

also more reliable. These systems were far less prone to failure than first-

generation computers and had an order of magnitude longer lifespan. The 

operation of transistors also consumed less power, which led to reduced cooling 

requirements and improved practicality of these machines. During this time, 

high-level programming languages like FORTRAN (Formula Translation) and 

COBOL (Common Business-Oriented Language) were created, which made it 

simpler to build and maintain code. These languages opened up programming 

to more people and added more flexibility to application development. This 

ultimately helped businesses realize the power of computers for data 

processing, inventory management, and complex calculations. 

It was also the second generation of computers, where the size and expense 

limited them to mainly major companies, government departments and 

universities. The introduction of transistors, albeit rudimentary, helped pave the 

way for more advanced computer systems that would follow in the next 

generation. The second generation also marked the move away from punch 

cards and paper tape toward direct input through keyboards and screens, a 

precursor to the interactive systems that would characterize later generations. 

The introduction of magnetic core memory also increased storage capacity and 

speed for the second generation. These innovations made computers more 

affordable and powerful, leading to improvements in wide areas including 

scientific research, business, and government. 

Third Generation (1964-1971): Integrated Circuits Improved Efficiency 

During the time of the third generation of computers (1964-1971), integrated 

circuits (ICs) were introduced. ICs (Integrated Circuits) are silicon chips that 

have many transistors, resistors, and capacitors placed on them. This was a
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remarkable mathematical and logistical advancement in the manufacture of 

computers that reduced the size and engineering requirements to a fraction of 

previous devices, and made computing faster, less power hungry, and more 

reliable. The development of integrated circuits led to the next stage of 

miniaturization of computers. In previous generations, semiconductor devices 

were separate components, which had to be wired; this required more complex 

assembly and consequently more expensive and larger computers than was 

strictly necessary; integrated circuits changed all of this in a way that greatly 

reduced the physical size and cost of computer production. The size dropped, 

which lowered manufacturing costs, and made computers available to more 

people. With the advent of ICs, computers became faster and more powerful 

since they could process more data in less time due to the miniaturization of 

electronic components on a single chip. This increase in performance and 

complexity was a watershed moment, making it possible to perform more 

sophisticated tasks and work with larger amounts of data. Being able to utilize 

multiple ICs in a system also enabled them to do much more parallel processing 

and multitasking, and as a result, generally use the entire system faster and 

more efficiently. Not just hardware, but also software got a major performance 

boost in the third generation. As operating systems became more robust   IBM's 

OS/360 is one of the better-known early examples   computers started to run 

more than one job at a time, dramatically increasing efficiency. Also, high-

level programming languages C and BASIC, to name a few became popular, 

which made programming considerably faster and easier. 

Mainframe computers, which were utilized by businesses and government 

agencies for large-scale data processing, payroll, and scientific applications, 

also became popular during the third generation. That is the kind of data with 

which they can deal with and can-do intricate calculations, and these kinds of 

machines were necessitated by the arrangement of associations that required 

automating capability. Integrated circuits, which were introduced in the third 

generation of computers, greatly increased the power and dependability of 

computing systems while simultaneously decreasing their size and cost. Their 

ubiquitous use paved the way for even more powerful and cheaper computers 

in its fourth generation. 

Fundamental 

Computer Skills 

MATS Centre for Distance and Online Education, MATS University



11 
 

Fourth Generation (1971-Present): Microprocessors Increased Computing 

Power 

Beginning in the 1970s and extending to the current day, the fourth generation 

of computers represented a revolutionary jump in computing power due to the 

invention of the microprocessor. A microprocessor is a semiconductor chip on 

which integrated circuits are embedded. Because of this breakthrough, smaller 

computers (and smaller computer-chip packages) became possible, enabling 

computers that were smaller, more powerful, and more affordable by 

individuals and small organizations instead of being limited by size or favoring 

huge organizations such as governments. Microprocessors revolutionized 

computing by packing many functions into one tiny chip. As a result of this 

development, personal computers (PCs) were released in the late 1970s and 

early 1980s., with corporations such as IBM, Apple, and Commodore driving 

the cost down, making computers affordable and readily available for the 

public. Not only could computers be faster and more powerful but it was also 

possible to make them much smaller than before, and much more energy-

efficient. 

People born between 1965 and 1980 were accustomed to personal computing 

growth, partly as a result of the creation of sophisticated operating systems like 

Microsoft Windows and the Macintosh operating system, as well as graphical 

user interfaces (GUIs). These types of interfaces simplified computer usage and 

let the user control their machine with a mouse and keyboard instead of 

complicated command-line text inputs. The rise of embedded systems is also a 

byproduct of the microprocessor development in the fourth generation. These 

are specialized computing devices integrated into common items, such as 

appliances, vehicles, and industrial machines. Such systems usually only do 

one function and are built to do so reliably and with little power consumption. 

Moreover, the fourth generation introduced networking technologies such as 

the internet that changed how people communicated and shared information as 

well as conducted business. Connecting computers and enabling individuals to 

search and access vast volumes of information online opened up new avenues 

for innovation and
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cooperation. The fourth generation is still defined by the rapid advancement of 

computing power, powered by innovations like multi-core chips and cloud 

computing and advances in artificial intelligence. Computers today are faster, 

more efficient, and more connected than ever, with applications spanning 

everything from gaming and entertainment to scientific research and artificial 

intelligence. 

Fifth Generation (Present & Beyond): AI-Based Systems with Advanced 

Capabilities 

The incorporation of artificial intelligence (AI) technologies and the growing 

capability of computing systems define the fifth generation of computers, which 

started in the 1980s and is still developing today. Fifth-generation computers 

aim to create devices that can mimic human intellect and carry out operations 

like learning, reasoning, and problem-solving that have historically required 

human cognition. 

Artificial intelligence (AI) technologies, such as computer vision, machine 

learning, and natural language processing (NLP), have advanced significantly 

in recent years, allowing computers to analyze enormous volumes of data and 

make judgments based on insights and patterns. Because algorithms can now 

learn from data and get better over time, machine learning in particular has 

completely changed industries like marketing, banking, and healthcare. 

Quantum computing, which uses the ideas of quantum physics to address issues 

that are now beyond the capabilities of traditional computers, is one of the main 

areas of work in the fifth generation of computers. Because they can process 

large amounts of data in parallel and carry out intricate calculations far more 

quickly than conventional computers, quantum computers have the potential to 

completely transform industries like cryptography, drug discovery, and 

optimization. Another significant advancement in the fifth generation is the rise 

of cloud computing. Cloud services allow individuals and organizations to 

access virtually unlimited computing power and storage through the internet. 

This has made high-performance computing more accessible and affordable, 

enabling businesses to scale their operations and collaborate in real-time across 

geographic boundaries. As we look toward the
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future, the potential for AI-based systems and quantum computing to transform 

industries and society is immense. From autonomous vehicles to advanced 

healthcare diagnostics and personalized recommendations, Innovations fueled 

by the fifth generation of computers could revolutionize how we work and live. 

The limits of what computers can accomplish will keep growing as AI systems 

continue to advance in capability, leading to new possibilities and challenges in 

the years ahead. 

UNIT 2 TYPES OF COMPUTERS 

Computers are categorized based on their size and purpose: 

Supercomputers: High-Performance Machines for Complex Calculations 

Supercomputers are the most powerful type of computers, designed to perform 

extremely high-speed calculations for complex tasks that require immense 

computational power. These machines are used in fields that demand 

substantial processing capabilities, such as scientific research, study on 

artificial intelligence (AI), climate modeling, nuclear simulations, and weather 

forecasting. Large volumes of data can be processed in parallel by 

supercomputers., making them capable of solving problems that would be 

nearly impossible for regular computers to handle. The capacity of 

supercomputers to do trillions or even quadrillions of calculations per second, 

as measured in FLOPS (floating-point operations per second), is their primary 

characteristic.). The architecture of a supercomputer is designed to allow for 

massive parallel processing, where thousands of processors work 

simultaneously on different parts of a problem, significantly speeding up the 

computational process. Supercomputers often consist of multiple 

interconnected systems, with each node in the system containing multiple 

processors. This architecture is known as a parallel processing system. 

These machines are used for a wide range of applications. In scientific research, 

supercomputers simulate complex phenomena such as molecular interactions, 

protein folding, and climate change. For example, they are essential in 

understanding the behavior of particles in physics experiments or
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modeling the Earth's atmosphere for weather predictions. In the military and 

defense sectors, supercomputers are used for cryptography, missile guidance 

systems, and simulations of combat scenarios. In healthcare, they assist in drug 

discovery and genomics by processing vast datasets to find correlations or 

predict outcomes. The most famous supercomputers, like IBM’s Summit and 

Fugaku from Japan, can execute hundreds of petaflops (one quadrillion 

calculations per second). These machines cost millions of dollars to develop 

and maintain, requiring dedicated facilities with specialized cooling systems 

and power sources. Due to their extreme processing power, supercomputers are 

often housed in climate-controlled environments to prevent overheating, and 

they consume significant amounts of electricity. Despite their advanced 

capabilities, supercomputers face challenges such as high operational costs, the 

need for constant upgrades, and their reliance on specialized software. 

However, their contribution to advancing scientific discoveries and solving 

complex global problems makes them indispensable tools in fields that require 

heavy computational power. 

Mainframes: Large Systems for Enterprise Applications  

Mainframes are powerful, large-scale computing systems used primarily by 

large organizations to manage and process vast amounts of data. Unlike 

supercomputers, which are designed for high-speed calculations, mainframes 

are optimized for reliability, scalability, and processing large volumes of data 

quickly and accurately. These systems have been in use for decades and are 

integral to industries like banking, insurance, healthcare, and government, 

where processing large datasets in real-time is crucial. One of the defining 

features of mainframes is their ability to handle multiple transactions 

simultaneously. They are designed to run multiple applications concurrently, 

providing centralized data processing for a wide range of business operations. 

Mainframes excel in environments that require high availability, as they are 

built with redundant components to ensure minimal downtime. In fact, many 

mainframe systems are so reliable that they can run continuously for years 

without failure. Mainframes also have a massive storage capacity, capable of 

handling petabytes of data. This is especially important in industries like
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finance and healthcare, where managing customer transactions, medical 

records, and other critical information requires vast amounts of storage. 

Mainframes can also support large numbers of users simultaneously, making 

them perfect for managing enterprise-level applications like supply chain 

management, enterprise resource planning, and customer relationship 

management (CRM). 

Although mainframes are not as fast or powerful as supercomputers in terms of 

raw computational speed, their strength lies in their ability to perform complex 

business processes and manage large-scale databases efficiently. They are also 

known for their strong security features, offering robust encryption and access 

control mechanisms to protect sensitive information. Mainframe systems are 

typically more expensive to purchase and maintain than smaller computing 

systems, but their scalability and reliability make them a valuable investment 

for large enterprises. Even in the era of cloud computing and distributed 

systems, mainframes continue to play a critical role in enterprise IT 

infrastructure, and their ability to support legacy systems ensures they remain 

relevant in today’s business world. 

Minicomputers: Mid-Sized Computers for Organizations 

Minicomputers, often referred to as "mid-range computers," were introduced in 

the 1960s as a cost-effective alternative to mainframes. These systems were 

smaller, less expensive, and more accessible than mainframes, while still 

providing a significant amount of processing power. Minicomputers were 

typically used by medium-sized organizations for business applications that did 

not require the scale of a mainframe. 

One of the defining characteristics of minicomputers was their ability to serve 

as a multi-user system, providing access to multiple terminals simultaneously. 

This made them ideal for tasks such as data processing, accounting, inventory 

management, and scientific calculations. Minicomputers were often used in 

industries like manufacturing, education, and research, where smaller-scale, but 

still powerful, computing systems were required. Compared to mainframes, 

minicomputers were more compact and easier to maintain, often
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requiring less floor space and specialized cooling systems. The smaller size and 

lower cost allowed many businesses to invest in minicomputers, democratizing 

access to powerful computing resources. These systems were also easier to 

program, as they often supported higher-level programming languages like 

BASIC, FORTRAN, and COBOL, making them more accessible to a wider 

range of users. While minicomputers were a significant advancement in 

computing, they were eventually overshadowed by the rise of personal 

computers and workstations in the 1980s. The advent of smaller and more 

affordable PCs allowed organizations to decentralize computing, reducing the 

need for large, centralized systems. However, minicomputers paved the way for 

the development of more powerful and user-friendly computing systems, and 

their impact can still be seen in modern computing technologies. 

Microcomputers (Personal Computers): Used by Individuals and Small 

Businesses 

Microcomputers, also known as personal computers (PCs), are the type of 

computers most commonly used by individuals and small businesses today. 

These computers are distinguished by their portability, low cost, and broad 

variety of general-purpose functions. With the development of the 

microprocessor in the 1970s, computers could now be constructed with smaller, 

less costly parts, opening the door for personal computers to become widely 

available. A central processing unit (CPU), memory, storage, input devices like 

keyboards and mouse, and output devices like displays and printers are the 

standard components of a microcomputer. Microcomputers have changed 

throughout time from being simple devices that could only run basic 

applications to being strong systems that can run sophisticated software, such 

as office productivity suites, graphic design tools, video editing software, and 

video games. 

The widespread adoption of personal computers revolutionized the way people 

work, communicate, and access information. In the business world, PCs have 

become essential tools for productivity, enabling tasks like document creation, 

data analysis, and project management. In education, they
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have transformed the way students learn, providing access to vast online 

resources and interactive learning tools. In addition to their use in business and 

education, Additionally, personal computers are now widely used for 

communication and entertainment. For millions of individuals, PCs are now an 

indispensable part of their everyday lives due to the growth of the internet, 

social media, and online gaming. Advances in hardware and software have 

made personal computers more powerful, user-friendly, and versatile, with 

many individuals using them for a wide variety of tasks, from creating digital 

art to conducting research to managing personal finances. Microcomputers are 

the backbone of modern computing and continue to evolve with new 

technologies like artificial intelligence (AI), virtual reality (VR), and cloud 

computing, ensuring that they remain relevant and indispensable in the years to 

come. 

Embedded Computers: Found in Appliances Like Washing Machines and 

ATMs 

Specialized computing systems called embedded computers are made to carry 

out specific tasks inside bigger machinery or gadgets. Embedded computers are 

designed to do particular activities inside the context of a device, in contrast to 

general-purpose computers, which may run a wide range of applications. These 

systems are typically small, power-efficient, and highly reliable, making them 

ideal for integration into everyday appliances and equipment. One of the most 

common examples of embedded computers is in household appliances such as 

washing machines, refrigerators, and microwave ovens. In these devices, 

embedded computers control functions like temperature regulation, motor 

speed, and user interfaces. For instance, a washing machine’s embedded system 

manages the wash cycle, ensuring that the correct water temperature, spin 

speed, and washing time are applied based on user input. Similarly, embedded 

computers in modern refrigerators monitor temperature and humidity levels to 

optimize food storage conditions. Embedded computers are also found in a wide 

range of other devices, including automobiles, medical equipment, industrial 

machinery, and ATMs. In automobiles, everything from engine performance to 

safety measures like
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airbags and anti-lock brake systems is managed by embedded systems. In 

medical devices, embedded systems monitor patient vitals and control medical 

instruments, ensuring accurate and reliable operation. ATMs rely on embedded 

computers to manage transactions, process card information, and dispense cash 

securely. 

The key advantages of embedded computers are their size, efficiency, and cost-

effectiveness. These systems are typically built into the device’s hardware, 

making them less visible to users but essential for the functionality of the 

machine. In many cases, embedded systems operate in real-time, providing 

immediate feedback and responses to changes in the environment or user inputs. 

With the latest generation of technology, embedded computers will 

undoubtedly be more intelligent and locally grouped. With the emergence of 

the Internet of Things, embedded systems have a more or less expanded role as 

the devices communicate to each other and share data in real-time. This led to 

the development of “smart” devices like thermostats, wearable fitness trackers 

and home automation systems, all of which rely on embedded systems that 

make them more functional and easier to use 

BLOCK DIAGRAM OF A COMPUTER 

A computer consists of five major components: 

1. Input Unit: Accepts Data (Keyboard, Mouse) 

Computer Systems the communication between the user and the machine, Its 

function is taking in data and instructions from the external world then turning 

those into a format that the computer can work with. These are fundamental 

tasks that must be completed before the computer can be used for creative work. 

Keyboards, mice, scanners, and microphones are examples of input devices. 

The most popular tool for typing text on a computer is a keyboard, which comes 

in a variety of varieties worldwide. Mostly One tool for entering commands and 

text into a computer is a keyboard. Carbon fiber switches are installed above 

two electric circuit systems in the keyboard, one for the letter

Fundamental 

Computer Skills 

MATS Centre for Distance and Online Education, MATS University



19 
 

and number keys and another for different function keys and inputs that can be 

interpreted by the computer's processor. Now, the mouse uses this same concept 

to let the user point, click, and drag on the screen to work with the computer. 

Mouse is a device consists of a sensor that detects movement and sends signals 

to the computer to navigate/select. Specialized input is achieved using other 

devices like scanners, microphones, and cameras. For instance, scanners 

transform these tangible papers or photos into digital information that a 

computer can handle and store. Microphones detect sound and translate it into 

a digital format, enabling voice commands or audio recordings. Another type 

of input is still-image or video cameras, which capture visual data from the 

environment. It is a Unit that is an input. The input unit is the most essential 

component of any machinery because it converts data into the format that the 

computer can process. It allows the transformation of analog signals into 

digital information that can be processed by the central processing unit (CPU). 

Moreover, the input unit also controls the communication among the different 

devices and the computer, enabling users to enter diverse data and also 

communicate in real-time with the machine. 

2. Processing Unit (CPU): Processes Data Using ALU and Control Unit 

The central processing unit, or CPU, is the brains of all computer systems. It 

manages data processing, computations, and command execution. It is 

frequently referred to as the computer's "brain" since it performs the 

fundamental tasks that keep the system functioning. The CPU is primarily 

composed of two parts: the control unit (CU) and the arithmetic logic unit 

(ALU). All mathematical and logical operations, such as addition, subtraction, 

multiplication, division, comparison, etc., are carried out by the ALU. It is 

based on binary digits and executes computations rapidly and precisely. The 

ALU not only performs basic arithmetic but is also responsible for more 

advanced bitwise operations (i.e., and, or, not), which are vital for a computer 

system. 

Control unit (CU): While A unit provides data & instruction to registers, Data 

flow between the CPU and other computer devices is managed by the CU. It 

serves as the system's "conductor," coordinating the actions of the
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input/output devices, memory unit, and ALU. CU fetches instructions from 

computer memory and decodes those instruction into control signals that 

control CPU operation. This is to ensure that the right sequence of operations 

is executed as designed, and so it coordinates the retrieval of data, its 

processing, as well as the output, in an orderly manner. 

The CPU operates in a cycle called the fetch-decode-execute cycle. During the 

fetch stage, the CPU fetches instructions from memory. During the decode 

phase, this from of instructions translate into signals that tell it what to do. 

Lastly, during the execute phase, the CPU will carry out the operation, be it 

calculating an arithmetic value, decision from logical operations, or a transfer 

of data. Modern CPUs have multiple cores and can handle many things at once. 

Due to the ability to run additional instructions simultaneously, computers 

equipped with multi-core Processors boast significant gains in performance for 

graphically intense tasks like gaming, video production, or scientific 

calculations. One of the most crucial pieces of hardware in your computer 

system is a processing unit., put it together with efficient cooling, powerful 

RAM, and well-designed CPUs, the processing unit makes a computer system 

really powerful. 

3. Memory Unit: Stores Data Temporarily (RAM) or Permanently (HDD, 

SSD) 

The memory unit houses the data that the CPU and the other parts of the 

computer system use. Primary memory and secondary memory are the two 

general categories into which memory can be divided. Devices like RAM 

(Random Access Memory) make up the primary memory, also known as main 

memory, which is used to temporarily store data while it is being processed. 

Primary and secondary storage characteristics Storage devices like Random 

Access Memory (RAM) that offer temporary storage for data and code currently 

being used by the CPU are referred to as primary storage or main memory. 

Long-term storage devices like solid-state drives (SSD) and hard disk drives 

(HDD) that are utilized for persistent data storage make up secondary memory. 
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Since RAM is a volatile memory, when the computer is turned off, its contents 

are lost. It is used to store the data that the CPU is now using or appending. The 

CPU can swiftly retrieve data that has to be altered thanks to this temporary 

storage space. When a file is opened or a program is run, it is loaded into RAM 

for fast access while the program is running. The RAM in a system is directly 

affected by how a system multitasks and its performance, especially as more 

RAM means that a computer can now work with larger and more complex tasks 

at the same time. On the contrary, Information that is stored for a longer period 

of time or permanently is kept in secondary memory. There are two kinds of 

secondary memory: solid-state drives and hard disk drives. HDDs store data 

using spinning disks and mechanical parts, but SSDs use flash memory, which 

makes them faster, more robust, and less power-hungry. Due to their superior 

performance and speed over HDDs, SSDs have gained popularity. 

So it’s a CPU that has a memory unit as well and this unit also contains a cache 

memory which is used for the fast processing. Cache is memory which stores 

frequently accessed data and instructions, instead of accessing RAM. It sits in 

between the CPU and RAM, saving time turning back to fetched data and 

increasing performance. Hence, the memory unit is responsible for handling the 

storage and access to information. It allows the CPU to quickly use the data 

being processed while also creating a permanent storage for files, applications 

and operating systems. 

4. Storage Unit: Stores Information for Long-Term Use 

The data has been stored in the computer systems for a prolonged time period. 

While the memory unit is designed for temporary data storage during 

processing, the storage unit retains data beyond the duration of that processing, 

preserving important information even after the computer has been powered 

off. There are two main types of storage: primary storage, which includes solid-

state and hard drives, and secondary storage, such as optical disks or tape drives. 
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As one of the most common types of storage, hard disk drives (HDDs) are 

ubiquitous. HDD contains magnetic disks that rotate and you store data on 

them. They pack a ton of storage space for the price, but HDDs are slower than 

newer types of storage is simply because they are mechanical. SSDs, or solid-

state drives, have grown in popularity as a replacement for HDDs. SSDs utilize 

flash memory for data storage, providing much higher read and write speeds, 

lower power consumption, and higher durability due to the absence of moving 

parts. SSDs are commonly found in modern laptops, desktops, and mobile 

devices. Optical disks (like CDs and DVDs) and magnetic tape drives are 

examples of secondary storage that are used for archiving and backup. Also 

have slower data access speeds than HDDs and SSDs, making them suitable for 

storing large quantities of data that are accessed infrequently. Another form of 

storage lately gained popularity is cloud storage. The storage of data on remote 

servers is referred to as cloud storage. This has many benefits: increased 

storage, accessibility from any number of devices, better backup and recovery. 

Data is written and read from the storage unit when needed, meaning the 

storage unit plays a big part in making sure that data is kept and ready to be 

used. It allows users to save a large amount of information consisting of 

operating systems, computer software applications, documents, and multimedia 

files, allowing a computer system to be available and ready for use. 

5. Output Unit: Displays Results (Monitor, Printer) 

The output unit presents the processed data or results to the user in a format 

that is readable or usable. Once the input data is processed by the CPU, the 

output unit is responsible for displaying, printing, or otherwise outputting the 

information to the user. Output devices are the hardware devices that represent 

the information processed by a computer. 

Most output devices are actually part of the display system, such as monitors 

that display videos, text or pictures. A monitor takes the electrical signals the 

computer is generating and translates them into visual signals that can be 

displayed on the screen. Monitors employ a variety of display technologies, 

such as liquid crystal displays (LCDs) or light-emitting diode (LED) screens
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in more recent versions and cathode ray tubes (CRTs) in older ones. The quality 

and resolution of the monitor, which relates to its pixel count and refresh rate, 

is a major factor in user experience, especially for graphics, video, and gaming 

tasks. Printers, function as an output device by transforming these digital files 

into the real world. Inkjet and laser printers both print text and images on paper 

with ink or toner. The common types are inkjet printers, laser printers, and dot 

matrix printers. Inkjet printers are great at high-end images and color 

documents, though, and laser printers are also better for fast, efficient printing 

of text. Other types of output devices are speakers, which take digital audio data 

and convert it into sound, as well as plotters, which can be used to create large-

scale high-resolution drawings and graphics. Output devices also encompass 

haptic feedback, such as vibrations in gaming or mobile applications. We need 

the output unit to provide the output of the calculations and to communicate 

with the user. Output is how users can view and interact with information 

processed by the computer; including, reading a report on a screen, printing a 

document, or listening to sound. 

MEMORY AND ITS TYPES 

1. Primary Memory: RAM (Temporary), ROM (Permanent Instructions) 

A computer system's primary memory is an essential component that stores data 

and instructions for use by the system either permanently or temporarily. 

Because it offers storage for the data that the processor needs to access instantly, 

it is essential to the seamless operation of a computer system. RAM and ROM 

are the two categories of primary memory. The first is temporary memory, 

sometimes referred to as temporary storage. DC claims that RAM is volatile 

memory, meaning that when the system is turned off, its contents are lost. The 

operating system, apps, and other running data are loaded into the RAM during 

regular system operation and are deleted when the computer shuts off. RAM is 

meant to provide faster access to data that is under action. The high speed of 

RAM ensures that processor access instruction and data at a more triadic 

location than the hard drives or SSD. It also improves multitasking. Mostly, the 

more the RAM, the more the number of programs
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that a system can run together and the level of data to be processed by system. 

ROM, on the other hand, is a read-only memory that contains instruction to boot 

and run the computer. ROM, according to DC, is non-volatile memory that 

maintains its content even when the system is off. During the booting process, 

ROM runs the BIOS or firmware that boots the system and determines system 

hardware. While RAM is possible to be written to, ROM id read-only. 

2. Secondary Memory: Hard Drives, SSDs, and USBs 

Secondary memory is used to describe storage devices such as hard drives, 

SSDs, that provide non-volatile storage of data, as opposed to primary memory, 

which is temporary and volatile. Secondary storage, Unlike primary memory, 

secondary memory stores data forever, even when the computer is turned off. 

You can keep the operating system, apps, and user files like documents on it., 

images, and videos. It provides much larger secondary memory compared to 

primary memory, but is very slow. The most common type of secondary 

storage is Hard Disk Drives (HDD). HDDs use a spinning magnetic platter to 

read from and write to. These are decades-old drives capable of reasonably high 

storage capacities but at a lower cost. However, they rely on mechanical parts, 

making them slower than newer storage technologies and more affected by 

physical shocks. 

SSDs (Solid State Drives) are the new,  faster choice than HDDs. SSDs store 

data in flash memory instead of hard disk drives (HDDs). This makes them 

much faster and more sturdy since they don't have any moving parts. However, 

this speed is very obvious when doing things like starting up an operating 

system or opening apps. Most of the time, SSDs cost more per gigabyte than 

HDDs., but the performance gain they provide makes them well-suited for 

applications demanding rapid data access. USB drives, which are also known 

as flash drives or thumb drives, are movable extra memory devices that store 

data on flash memory. The drives can be taken with you., compact, and widely 

adopted for file transfer between computers. USB drives, also known as flash 

drives are extremely portable and can be plugged into a USB port to quickly 

transfer or store data. They have less storage than HDDs
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or SSDs, so they are not used for large storage backups, but fine for transferring 

documents, photos or small apps. It helps in storing data permanently for a long 

time which is stored by users for retrieval as per requirement. 

3. Cache Memory: Speeds Up Data Retrieval 

Cache memory is fastest, smallest and temporary memory, which is located 

very near the CPU and stores recently accessed data and instruction. There is 

one primary reason to use it and that is to help the computer retrieve data and 

speed up system performance by less time of the CPU accessing slower memory 

units such as RAM, hard disks, or secondary storage devices. As the CPU 

executes a sequence of instructions, the first thing it does is check to see if the 

data has been placed into the cache. If the requested data is there, this event is 

called a cache hit, and the CPU can proceed with its operation with a negligible 

delay. The CPU has to read the data element from a slower RAM or secondary 

memory, which adds to the delay, if the needed data element is not in the cache. 

This is called a cache miss. 

Cache memory operates by holding a limited number of most used data and 

instructions that are expected to be next requested. Operating at speeds 

exponentially quicker than RAM, it allows near-instant access for the CPU to 

the foundational data needed for continued processing. There is usually a 

hierarchy of cache memory, typically L1, L2, and L3 caches. L1 cache is the 

smallest and fastest; it lives on the CPU chip itself. L2 and L3 caches are bigger 

and slightly slower; they either live on the CPU chip itself or on different chips 

close to the processor. Since cache memory is slower than RAM, it reduces the 

delay related to data fetching, enabling the CPU to function fontanelle 

efficiently. However, modern processors break apart this bottleneck by 

utilizing complicated cache hierarchies to boost performance, causing a sharp 

drop off in the number of cycles it takes to retrieve data from memory.
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4. Virtual Memory: Uses Part of the Hard Drive as RAM 

Virtual memory is a type of memory management that lets a computer use a 

part of the hard drive or SSD as if it were extra RAM when it doesn't have 

enough real RAM. This enables the system to execute larger applications, or 

multiple programs, at once even if sufficient physical RAM isn't available. 

When a computer does not have enough available used a part of the hard drive 

virtual memory. The swap file or page file is the name for this part of the hard 

drive. This system moves data from the RAM to the swap file when it's not 

being used. This makes room in the RAM for jobs that are currently running. 

When the data in the swap file is required once more, it is swapped back into 

RAM. 

While virtual memory helps the system memory to be used more effectively 

and allows for multitasking, getting information from virtual memory takes 

longer than retrieving information from physical RAM. That is simply due to 

the fact that hard drives and SSDs are orders of magnitude slower than RAM. 

So, heavy usage of virtual memory may result in slow system performance, 

especially when applications that require more memory are run. You are not out 

of the need of making use of the term reason behind virtual memory. 

Fortunately, enough physical RAM is very important for the system to perform 

normally. 

STORAGE DEVICES 

1. Magnetic Storage: Hard Disks, Floppy Disks 

Magnetic storage Magnetic storage devices are data storage devices that store 

data on magnetized medium. One of the oldest forms of secondary storage, it 

remained for many decades the most used form of secondary storage, with 

items like hard disk drives (HDDs) and floppy disks being classic examples. 

HDDs are mechanical drives that write data on spinning magnetic platters. 

Platters spin underneath a read/write magnetic head that moves all over their 

surface to write/read data. At relatively high storage capacities, they are still 

commonly used for personal and enterprise-level data storage. Although they
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are less expensive than newer storage media like SSDs, they are slower and 

more susceptible to mechanical failure due to the moving components. 

Floppy disks were a prevalent method of intermediate data storage in the 1980s 

and 1990s, and operated on a similar magnetic principle, but at a far less robust 

and smaller scale. A floppy disk, on the other hand, was a thin, flexible disk 

coated with magnetic material and read by a disk drive. Floppy disks were 

used to transfer small files between computer systems, but most have long since 

been replaced by new generations of much larger and more dependable storage 

devices, such as USB data drive and external hard disk. Magnetic storage 

devices have been a foundation of personal computers, providing low-cost and 

dependable ways of storing data and programs for the past several decades. 

While HDDs have been phased out to some extent for a much faster option, 

these devices are still heavily-used devices even today with SSD and Cloud-

based storage solutions replacing its role for the need for speed. 

2. Optical Storage: CDs, DVDs 

Anyone who has ever used a CD, DVD, or Blu-ray knows that optical storage 

employs laser technology to read and write data on a disc. Optical storage most 

commonly refers to CDs (Compact Discs) and DVDs (Digital Versatile Discs) 

The data is contained within the pits and the lands on the surface of the disc, 

which an optical drive reads via a laser beam. CDs were launched in the early 

1980s and soon became a household format for music, software, and other data. 

A common for higher density CD can store 700 MB of data, sufficient for 

smaller files and applications. The DVD, which was introduced in the late 

1990s, offered drastically increased storage capacity, generally in the 4.7 GB to 

9.4 GB range for single- and dual-layer discs, respectively. This made DVDs a 

perfect medium for holding video files, movies and larger software 

applications. 

Although optical storage has been one of the main media for distributing 

software and media, since the introduction of digital downloads and streaming, 

it has been continuously faded out by other storage technologies
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such as USB drives and cloud storage. Optical discs are still used for archival 

needs, since they are a cheap and reliable way to store long-term, especially for 

high-definition video on formats like Blu-ray. 

3. Flash Storage: USB Drives, SSDs 

Flash storage uses flash memory chips to store data. Flash memory does not 

contain moving parts like traditional magnetic storage, which makes it faster 

and more durable. Flash storage devices include USB drives (also called flash 

drives or thumb drives) and solid-state drives (SSDs). USB drives are small, 

portable devices that can be connected to a computer's USB port. They are fast, 

easy to use, and relatively inexpensive, which is why they are popular for 

transferring files and other data between devices. They provide mid-sized 

storage capacities, typically somewhere in the range of a few gigabytes up to 

many hundreds of gigabytes in size, great for documents, photos, and any other 

portable data. Solid State Drives (SSD) are high-speed storage devices that use 

flash memory to hold data. They provide much higher read and write speeds 

than traditional hard drives, which makes them great for use as storage for 

operating systems, applications, or games, where you need quick access to the 

data. Solid State Drives (SSDs) are now the storage medium of choice for many 

modern PC systems, providing SDDs with speed and dependability. Due to the 

speed, portability, and durability of flash storage, it has become a popular 

choice, not only in traditional computing devices but also in the form of 

smartphones, tablets, and other high-tech electronics. 

4. Cloud Storage: Online Data Storage Solutions 

Cloud storage or in a simple way cloud storage is a way of online data storage. 

Cloud storage, in contrast to traditional data storage methods such as hard disk 

or USB drives, allows data to be stored on remote servers managed by cloud 

service providers. Given that cloud storage allows users to retrieve files from 

any device that is connected to the internet, this service is useful for both 

personal use and commercial use. There are different storage plans for many 

cloud storage services, such as Google Drive, Dropbox, and OneDrive; both 

free and paid ones. Data loss is no longer a problem with
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cloud storage. It frees you from the need to invest in physical storage devices, 

and most cloud services automatically back up your data. 

For one, cloud storage is scalable, which makes it possible for users to expand 

their storage as needed without the hassle of purchasing hardware. 

Additionally, the ability to share files and collaborate in real-time, makes it a 

great resource for teams and businesses. Storage of cloud data is one of the 

most significant advantages to be had from it being flexible and available. 

However, it does require a stable internet connection, and and users run the risk 

of trusting the third-party provider with their data. Nonetheless, even though 

there is no book for cloud storage, its necessity in storing files has transformed 

previously used systems into something completely new. 

COMPUTER NETWORK 

A computer network is thus a collection of devices that allows for resource 

sharing. Types include: 

1. LAN (Local Area Network): Connects Computers within a Small Area 

A perp-based network that connects computer or other peripherals in a limited 

area of space, for a LAN involves terms that connects computers or peripherals 

in a limited space such as home, office, or a building. Network in a small area 

Based on its name, a local area network (LAN) is a type of network that 

connects a few devices in a small area. LANs are generally limited to a single 

building or campus but can span multiple nearby buildings depending on the 

needs of the organization or facility. Pros of Local Area Networks (LANs)One 

of the key benefits of LANs is the speed of data transfer, typically via wired 

Ethernet cables, or, nowadays, through blazing fast Wi-Fi connections. 

Architecture LAN has a simple architecture since it connects devices to a 

central device (e.g. switch/router). For wired local area networks (LAN), 

devices are connected to a central switch via Ethernet cables, and for wireless 

LAN (WLAN), devices connect via radio signals to a wireless access point 

(AP), which accesses the rest of the network. 
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Choosing the right LAN and router will be highly determined by the size of the 

environment you are working in. To illustrate, users within an office may share 

documents, printers, indeed access common software tools or databases 

located on a file server. LANs also offer easier oversight and security, since a 

single administrator or IT team usually manages all of the devices. For 

example, technologies such as Gigabit Ethernet provide data rates of up to 1 

Gbps, while wireless LANs that use modern standards such as Wi-Fi 5 or Wi-

Fi 6 can achieve speeds which rival that of wired connections in many 

applications. The high-speed nature of LANs makes them suitable for settings 

where high-volume data transfer is crucial. LANs also facilitate different forms 

of communication, including file sharing and video conferencing, allowing 

users in the network to collaborate with each other. As businesses and 

organizations can implement firewalls, encryption, and access controls in their 

LANs, security is also an important aspect of LANs, to control access to 

sensitive data. One disadvantage with LANs is the range though. Because 

LANs are meant for small geographic areas, they are not used to connect 

devices over large distances. For wider communication other network types 

like WAN or MAN are utilized. However, LANs are still a critical aspect of 

contemporary computing infrastructure because of their speed, cost efficiency, 

and ease of implementation. 

2. WAN (Wide Area Network): Covers Large Geographical Areas 

How to Understand WAN (Wide Area Network) A Wide Area Network, or 

WAN, is a big wireless network that covers a lot of space.A WAN can be in a 

city., a country or multimode between world continents. WANs, unlike local 

area networks (LANs) that are limited to small areas, provide connectivity over 

longer distances, enabling businesses, organizations, and individuals to 

communicate and share data over vast regions. WANs are usually popularized 

by the internet, where millions of computers are connected globally. WANs 

employ various technologies and communication mediums (leased lines, fiber-

optic cables, satellite links, and wireless networks) to connect devices or 

networks in distant locations. WANs are thus ideal for large organizations 

including enterprises, universities, government bodies, and service providers
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with widely distributed offices, data centers, and users. An essential 

characteristic of WANs is their capacity to transfer large volumes of data traffic 

over extended distances. They offer fast links that allow communication 

between different sites. For example, a WAN allows employees working for an 

organization with offices in New York, London and Tokyo to access shared 

resources, attend video conferences and collaborate on projects as if they were 

located in the same location.  

The complex and expensive nature of the physical infrastructure of a WAN is 

mitigated by the fact that it can cover large geographic areas, making it 

invaluable for organizations with a global presence. Many service providers 

offer management of WAN connections as a service so they can be leased by 

the enterprise assuring reliable connectivity and secure transfers of information 

from site to site. Scalability is another major benefit of WANs. As an 

organization’s requirements grow, a WAN can be expanded to connect 

additional areas, add higher-speed links and support more data traffic. The 

hardening of traditional WANs is beginning to change due to the adoption of 

technologies such as Multiprotocol Label Switching (MPLS) and Software-

Defined WAN (SD-WAN) which allow data to be routed dynamically based on 

real-time conditions, bandwidth availability, and traffic demands. Of course, 

WANs also have their challenges. However, the expense of building and 

maintaining a WAN, especially over a significant distance, can be high. From 

your perspective, maintaining security on a WAN requires strong encryption, 

firewalls, etc., to prevent data breaches and protect against unauthorized access. 

WANs provide distance communication and despite the above issues still 

remain a backbone of today's networks. 

3. MAN (Metropolitan Area Network): Connects City-Wide Networks 

Alternative Name Metropolitan Area Network (MAN)This is a type of network 

for a city or a metropolitan area in which computer and devices are connected. 

A MAN is a bigger version of Local Area Network (LAN), which usually 

covers a building or group of buildings, while also being smaller than Wide 

Area Networks (WANs), which cover a large geographical area. The Data 

transfer guide is MANs which acts as an umbrella for interconnecting
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multiple LANs (home, offices, etc) within a city, and they facilitate high-speed 

data transfer and communication between businesses, government institutions, 

educational organizations, and other people in the same metropolitan area. 

Architecture of MAN allow it to provide much higher speed and more 

bandwidth than standard broadband connections popular in homes and small 

offices. Fiber-optic cables, Ethernet, and wireless (WiMAX) technologies are 

typically used in the construction and maintenance of MANs for high-speed 

transmission of data from device to device and network to network within the 

city, which will help the data to be transferred at a higher speed. 

So one of the most significant benefits of setting up a MAN is that it enables 

local organizations or institutions to share resources and data without the need 

for a WAN, which tends to be more costly also not suited for urban-scale 

communications. For instance, businesses that are located in the same city can 

use a MAN to connect their offices to a local data center or cloud server, 

allowing them to quickly access shared information and services in a secure 

manner. Apart from business-use applications, Metropolitan Area Networks 

can also be used to support public services like connecting schools, universities, 

hospitals, government agencies, and libraries to a central network. Several cities 

have started working on Smart City projects, where the MAN can be used to 

connect various city infrastructure such as traffic management systems, public 

transportation, emergency services, etc. But, MAN's are expensive to install as 

they involve with specialized hardware and availability of infrastructure to 

facilitate transmission of high speed data over spreads of area. Another 

drawback of MAN is the security; the traffic data in MAN moves to a more 

extensive geographical area as compared to that in a LAN, which increases the 

chances of data interception and attacks. These issues aside, MANs can be a 

great asset for companies investing in high-speed communication within 

metropolitan regions. So, they are an important part of modern networking by 

helping to reduce latency, improve communication and share resources between 

various entities in efficient ways. 
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4. Wireless Networks: Wi-Fi, Bluetooth, and Mobile Networks 

Wireless networks are communication systems that enable data transfer 

between devices without the need for physical cables, utilizing radio waves, 

infrared, or other wireless technologies. Examples of wireless networks include 

Wi-Fi, Bluetooth, and mobile networks (e.g., 4G, 5G, and WiMAX). These 

networks have changed the way we connect to the internet, interact with people 

and share data to give us flexibility, mobility and convenience. Short for 

Wireless Fidelity, Wi-Fi is among the most well-known wireless technologies 

in use today; Wi-Fi is used to offer high-speed internet to the homes, offices, 

cafes, airports, and public areas. Wi-Fi Network Types: Wi-Fi transmit wireless 

signals between a wireless router (access point) and devices such as laptops, 

smartphones, and tablets using radio frequency. It runs on bands like 2.4GHz 

and 5GHz, with the newest Wi-Fi 6 tech providing higher speeds, higher 

capacity, and better effectiveness in bustling areas. Bluetooth is another 

common wireless technology, mainly designed for short-range communication 

between devices. Bluetooth is a wireless transmission standard for short 

distances. Bluetooth is another short-range technology that lets devices talk to 

each other using the same 2.4 GHz frequency band. It has more relevance in 

working with personal area networks (PANs) where there is a limited range to 

keep devices in communication. Mobile networks like 4G and 5G are 

revolutionizing communications, providing peace-of-mind global broadband 

internet. Mobile networks rely on a series of cellular towers to deliver wireless 

coverage to mobile, enabling you to stay connected to the internet, make calls, 

and send messages. We take less than 5 years to evolve from 4G to 5G, & it 

was a leap, which has increased speed, reduced latency, and increased capacity, 

paving the way for things like autonomous cars, interconnected cities and smart 

objects, and also for mobile applications. 5G is the next generation of mobile 

networks, succeeding 4G, providing high-speed data transfer and low latency, 

with measures to support future IoT requirements. 

Phone service is already available and mobile operators are experimenting with 

WiMAX, which provides long-range broadband wireless access over
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large areas. WiMAX is particularly well suited for rural or underserved areas 

where typical broadband infrastructure might not be available or too expensive. 

Ease and flexibility is the biggest benefit of wireless networks. They enable to 

access the internet or communicate with other devices from just about 

anywhere, without being tied to a specific location. But wireless networks are 

vulnerable to interference, signal congestion, and a breach risk because data can 

be more easily intercepted or disrupted than with wired networks. 

Nevertheless, wireless networks are constantly evolving, with speeds 

increasing, coverage improving, and connectivity becoming more reliable 

across a wide array of devices and applications. The focus of wireless network 

research is on developing fast, reliable communication technologies that will 

enable the next generation of mobile and connected devices. 

UNIT 3 SEARCH ENGINE CONCEPT AND WORKING 

OF SEARCH ENGINE 

We should consider using search engines for finding information on the 

internet. They work by: 

1. Crawling: Bots Scan Web Pages 

Crawling refers to the method search engines use to systematically explore the 

vast internet world, collecting information about different web pages as they 

go. The process of doing this is automated by software applications, commonly 

called web crawlers or spiders. These bots (known as crawlers or spiders), and 

they follow links through the web from one page to another, collecting content, 

metadata, and other essential information that helps the search engine 

understand the web in structure and context. Why do businesses need to know 

here how crawlers interact with a webpage? Only page content to be included: 

text, images, videos, links, etc. Web crawlers are usually started with a list of 

seed URLs, from which they visit these URLs and follow links to other pages 

within the same domain or another domain. Crawlers use a number of 

algorithms to determine how to visit pages, deciding which ones to visit first 

based on how often a page is updated or how valuable it thinks the website is, 

for example. 
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The bots are quick and efficient, scanning pages by the millions each day. The 

crawling process will never be completed as most dynamic web pages will be 

either created, updated, or deleted. Sometimes, crawlers are made to follow a 

site's "robots.txt" file, which tells search engines which pages not to crawl. It 

gives website owners the power to control how much of their information 

search engines can see. The first and most important step in the process of 

search engines is crawling, which is the foundation of the whole search 

environment. If not done well, a search engine couldn’t find or consume a 

website’s content and couldn’t serve a user with relevant results. Hence, web 

crawlers are crucial for enabling search engines to deliver accurate, relevant, 

and comprehensive search results. 

2. Indexing: Data Is Stored in Massive Databases 

The next step in the process of the search engine, after a spider has crawled and 

collected content from a page, is to index it. Indexing means storing and 

organizing this huge amount of data into large databases which can be retrieved 

in most user-friendly and efficient way whenever needed. Indexing can be 

thought of as recording a digital library of every web page that has been 

crawled. This is when a search engine will read through a page and parse out 

its content into a structured form, using crawlers to identify fundamental 

information such as keywords, phrases, headings, links, and metadata. This 

information is then indexed and stored in a huge database, called an index that 

enables search engines to discover and retrieve relevant content once a user 

does a query. The index is basically a picture of the web — a search engine’s 

knowledge of all the web pages it has crawled. Indexing is not just about storing 

raw content; it also involves analyzing the context of the content. For instance, 

search engines might account for things like the relevance and authority of a 

page and the relationships it holds with other pages on the web. This aids in 

deciding how relevant a page is to a user query’s context. 

Search engines have well-designed algorithms to structure and optimize their 

indexes to provide rapid retrieval. As the web expands, the index does too, 

becoming a massive database of information from billions of web pages. To 

accomplish this, extremely efficient systems are needed to ensure that the
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search engine quickly looks up the appropriate results — even when a 

ridiculously huge and ever-changing sea of information is stored 

internationally. This process of indexing is essential as it helps search engines 

to generate data provided quickly and accurately. Without an index, a search 

engine can’t efficiently process user queries, and it would be unable to display 

results that are relevant to users. The indexing is highly crucial where when a 

user enters any query then the search engine retrieves the most relevant pages 

from the gigantic database. 

3. Ranking: Algorithms Rank Pages Based on Relevance 

Ranking is the algorithmically-driven method by which the search engines 

determine in which order indexed pages are displayed when a user makes a 

search query. After crawling and indexing the web, a search engine ranks pages 

based on their relevance to the user's search intent using increasingly complex 

algorithms. A major contributor to how search engines delivers the most 

relevant and helpful results to users is Ranking. There are hundreds, even 

thousands of factors that influence the algorithm Google uses to calculate where 

a webpage will show up in search. Some of these elements include the 

relevance of content, keyword usage, load speed of the page, mobile-

friendliness, backlinks, user experience, and the authority of the site. For how 

a user searches for a term such as (best coffee shops near me), will search engine 

prioritize pages that are relevant to that query and will rank them according to 

the quality and relevance of the content perceived. 

As natural language processing (NLP) is used by search engines to understand 

what is meant by certain words or phrases in a query, and analyze user intent, 

this approach is well-suited to the field of search. For instance, when you search 

for "buy a laptop," the search engine knows the user is looking to make a 

purchase, so it will return commercial or transactional pages rather than pages 

containing information. Another significant ranking factor in Google are 

backlinks. Search engine algorithms considering backlinks, other than crawler 

going through each page, makes pages with authoritative page rank and 

relevant backlinks generally ranked higher due to the belief surrounding the 

validators that you have a value and can be trusted.
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The way search engines rank results is constantly evolving as search engines 

update and improve their algorithms to provide better results to the searchers. 

This is often a closely guarded process, as search engines such as Google   

constantly update their algorithms to prevent between themselves and improve 

the accuracy of results. Trying to make web pages rank better is not a new 

phenomenon   after all, SEO (search engine optimization) specialists are 

literally working on doing that   however, the algorithms are there to support 

rewarding high-quality, user-interest content while punishing pages trying to 

use manipulative tactics such as keyword stuffing or purchasing backlinks. 

Search engines aim at crawling and indexing, effective ranking is the key for 

search engines to get the best possible relevant results for the user, thus 

satisfying the user experience. 

4. Retrieving: Users Get Results Through Queries 

The last stage in search engine procedures is based on retrieving result for users 

via queries. When a user types a query into a search engine, the search engine's 

algorithms rapidly process that query, analyze the indexed data, and return the 

most relevant content. This is the step users see when they open the browser as 

they are presented with a list of search results on the screen. The process is 

triggered whenever a user inputs a search query. The search engine then 

matches the query against its index and finds pages relevant to the keywords 

or search terms used by the user. Using its ranking algorithms, the engine 

arranges the pages in order of relevance, authority, quality and so on. These 

results are generally displayed as a search engine results page (SERP), which 

features a list of URLs, descriptions of each URL, and, in some cases, not other 

elements such as images, maps, or news articles. 

The retrieved results can also be personalized from search history, location, 

and preferences of the user. So, if a certain user searches for tech-related content 

on a popular search engine, that search engine will know that user loves tech 

content and will show tech websites as a priority. To take a similar example, if 

the user is looking for a local service, the search engines might suggest the 

results which are geographically significant, like a coffee place or a plumber 

close to the user. Designed for speed, the retrieval process returns
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relevant information almost immediately. That is the reason behind search 

engines operating extremely agile and resilient architecture, capable of handling 

billions of searches queries a day. Delivering search results is about extracting 

values from your search engine and presenting them to the user in an effective 

manner to deliver the most reliable, accurate, and timely information relative 

to a search query. How the final list of results looks also depends on whether 

the type of search query and whether the user has triggered any advertising 

campaigns (e.g. Google Ads). These ads appear at the top or bottom of the 

SERP and are labeled as sponsored to include them from mainly organic results. 

During retrieval, speed and accuracy are critical. They want instant access to 

relevant information, and it is the ability of a search engine to return the best 

available results from its index as a response to a query that dictates its success. 

1.10 OPERATING SYSTEM AND NUMBER SYSTEM 

An operating system (OS) is a type of software that controls the hardware and 

software tools of a computer. It works as a go-between for the user and the 

computer hardware and gives programs a stable place to run. It manages 

hardware parts such as the CPU, memory and storage, and provides the users 

with a user-friendly interface to work with. Now, breaking those functionalities 

of an operating system into few main categories: 

Resource Management: The OS handles hardware resources, such that 

different applications and users can access the appropriate resources of the 

system. It is responsible for handling the CPU, memory, disk space, and 

input/output devices. It is responsible for resource management and allocation 

based on priority, avoiding conflict, and providing for environment usage. 

Process Management: An OS creates, schedules, and terminates processes 

(running programs). Cross-platform means that it supports execution on 

different types of devices such as computers and mobile devices and network 

systems that are used by users together. This covers process synchronization, 

scheduling, communication, etc. 
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Memory Management: The O.S manages the memory of the system which 

allows it to allocate space in memory whenever necessary for a currently 

running process and also ensure that one process does not overwrite the 

memory of some other process. It uses methods such as virtual memory to 

enhance the effective memory of the system by using hard disk space to act as 

RAM when it is not present.  

File System Management: The OS organizes and manages files on storage 

devices (such as hard drives or SSDs). It maintains records of where files are 

located, permissions for files, and security, enabling users and applications to 

read, write, and manipulate data in with ease. It also provides a set of 

management tools for creating, deleting, and accessing files. 

Security and Access Control: OSs have security features like user 

authentication, encryption, and access control to keep data safe from people 

who shouldn't have access to it. Such as password protection, user access, and 

firewalls. 

Examples of popular operating systems include: Windows, macOS, Linux: 

Windows: Designed by Microsoft, Windows is perhaps the most common 

operating systems use, especially for business and personal computer. It offers 

a GUI which means that users can interact with the System using Clicks, 

Windows and Menus. 

macOS: macOS is the operating system for Apple’s line of computers and is 

developed by Apple Inc. Widely appreciated for its clean interface and user-

friendly experience, macOS is widely used in creative fields because of its 

stability and compatibility with other Apple products. 

Linux: Linux is a Unix-like, open-source operating system. It is recognized 

for its stability, security, and flexibility. This allows anyone using it to make 

many tweaks to how the OS will behave, which has made it popular in server 

environments, tech development, embedded, and more. There are a multitude 

of Linux distributions (distros), with popular ones being Ubuntu, Fedora, and 

Debian to address various user needs. 
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An important part of a computer system is its operating system (OS). This not 

only allows it to work efficiently but also gives necessary services to users and 

applications, keeping the operating system free, secure, and responsive. 

Number System: Used in Computing 

In computer science, there are a series of number systems that form the basis 

of how we represent and manipulate numbers. There are multiple number 

systems (binary, decimal, octal and hexadecimal) that serve different purposes 

in the digital world. This form of representation is essential for anybody 

dealing with computers and also for developing hardware and software where 

you will need to do numbers. 

Binary (Base 2): 0s and 1s (Used in Digital Computers) 

Modern computing is based on the binary number system (base 2). It represents 

all numbers and data using only two digits, 0 and 1. At the hardware level, the 

binary system is a reasonable choice for expressing information, since digital 

computers are composed of transistors that can only be in one of two states, 

either on or off. 

The ite(s)x bit(s) in binary (base 2) are called Bits (Binary Digits and each Bit 

represents an increasing power and i represented from its right-most bit where 

the right-most bit remains the least significant 0 or 1 representing the least 

power i.e., 2^0. Take the binary number 1011 as an example; it stands for: 

1 * (2^3) + 0 * (2^2) + 1 * (2^1) + 1 * (2^0) 

This equals 8 + 0 + 2 + 1 = 11 in decimal. 

Binary honestly is the most basic level to which a computer can store and 

manipulate data because it encodes all forms of data (characters, images, sound, 

etc) using strings of 0s and 1s. 
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Decimal (Base 10): Regular Numerical System 

The decimal (base 10) number system is the one most people use in their daily 

lives. It uses the ten characters 0 through 9 to show numbers. Because each 

place value is a power of 10, the value of each number depends on how many 

places it is from the decimal point. As an example, the number 345 in decimal 

form can be written as: 

3 * (10^2) + 4 * (10^1) + 5 * (10^0) 

This equals 300 + 40 + 5 = 345. 

Computers do not process the data in decimal directly, but UTF-8 system based 

on decimal used as human user commonly. Binary and Decimal conversion 

this is a very often required conversion; most of the time, while programming 

or working on numbers on a computer, computers always calculate in binary. 

Octal (Base 8): Used in Computing Applications 

Numbers in the octal (base 8) system are made up of eight digits, ranging from 

0 to 7. Each number represents an 8th power. People don't use the octal scheme 

as much in everyday life, but computers do, especially in the context of file 

permissions and in certain legacy computer systems. Octal is a way to write 

binary quickly. Each group of three binary numbers is shown by a single octal 

digit. In this case, the binary number 101101 can be broken down into 101 and 

101., which both correspond to octal digit 5. Therefore, in octal, 101101 is 55. 

Octal was more common in previous computing platforms but fell out of favor 

in the present day and has been mostly replaced by hexadecimal, only because 

the conversion of binary and hexadecimal is easier. 

Hexadecimal (Base 16): Simplifies Binary Representation 

And more generally, a system from (2 segments) to (F segments) corresponds 

to (8s) to (15 segments) that is, including forms A through F or 10 through 15 

in decimal (hexadecimal). In computing, hexadecimal is used to simplify the
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representation of binary data. Because one hexadecimal digit can represent four 

binary digits (or bits), it is thought to be smaller and easier to read than long 

binary numbers. As an example, the 4-bit binary number 1111 1010 can be 

written in hexadecimal as FA. 

It is common to use hexadecimal in programming, especially in memory 

addresses, color codes in graphics, and low-level system programming. It is a 

middle ground between the binary system on which computers operate, and the 

more familiar decimal system allowing people to manipulate large binary 

numbers in a more manageable manner. The number systems binary, decimal, 

octal, and hexadecimal  form the bedrock of computing. At the hardware level, 

binary is the core system that computers use to process numbers, whereas 

humans use decimal the most. So, octal and hexadecimal are useful in 

simplifying binary data in a way that is more manageable, however, 

hexadecimal counts are the more common form. These number systems are 

vital for computer professionals to improve comprehension on how data 

operated in different data processing platforms. 

Input and Output Devices in Computing 

Input and output devices are fundamental components of a computer system 

that facilitate interaction between the user and the computer. Input devices 

allow users to send data and commands to the computer, while output devices 

enable the computer to display, print, or project results of processed data. Both 

types of devices are essential for efficient computer operations in various fields, 

including business, education, entertainment, and research. 

1. Input Devices: Input devices are hardware components that enable users to 

enter information, control operations, or provide instructions to a computer 

system. They act as the bridge between the user and the machine, allowing data 

to be processed. Some common types of input devices include: 

a) Keyboard: One of the most widely used input devices, the keyboard allows 

users to type text, enter numbers, and execute commands through keys.
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It includes function keys, numeric keys, alphabetic keys, and special keys such 

as Enter, Shift, and Ctrl. Used in everyday computing, programming, and data 

entry tasks. 

b) Mouse: A pointing device that enables users to navigate, select, and interact 

with items on the screen. Includes features like right-click for additional 

options, scroll wheels for smooth navigation, and optical sensors for precision. 

Essential for graphic design, gaming, and regular computer use. 

c) Scanner: Converts physical documents, images, or barcodes into digital 

formats. Common types include flatbed scanners, barcode scanners, and 

handheld scanners. Used in offices, libraries, and retail stores for record-

keeping and document processing. 

d) Microphone: Captures audio input, allowing voice recording, 

communication, and voice commands. Used in applications such as video 

conferencing, voice recognition software, and speech-to-text programs. Plays a 

crucial role in virtual assistants like Siri, Google Assistant, and Alexa. 

e) Joystick/Game Controller: Used primarily for gaming and interactive 

applications. Provides enhanced control in video games, flight simulators, and 

virtual reality (VR) experiences. Includes buttons, triggers, and motion sensors 

for an immersive gaming experience. 

f) Touchscreen: A hybrid input device that allows users to interact directly with 

the screen by tapping, swiping, or pinching. Found in smartphones, tablets, 

ATMs, and modern laptops. Eliminates the need for a separate mouse or 

keyboard. 

2. Output Devices: Output devices are responsible for presenting the processed 

data to the user in visual, audio, or physical formats. These devices make it 

possible for users to view, hear, or print results from a computer. Some common 

output devices include: 
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a) Monitor (Screen/Display): The most commonly used output device that 

visually displays text, images, videos, and graphical data. Comes in different 

types such as LCD, LED, and OLED screens. Higher resolution monitors (e.g., 

4K, 8K) are used in gaming, video editing, and professional design work. 

b) Printer: Converts digital data into physical documents, images, or labels. 

Common types of printers include: 

Inkjet Printer – Suitable for home use with high-quality color printing. 

Laser Printer – Preferred in offices for fast and high-volume printing. 

3D Printer – Produces three-dimensional objects layer by layer using plastic 

or metal materials. 

Used in businesses, educational institutions, and publishing. 

c) Speakers 

• Produce audio output by converting digital signals into sound. 

• Used for music, video calls, gaming, and multimedia applications. 

• Advanced speaker systems include surround sound setups and 

Bluetooth wireless speakers. 

d) Projector 

Displays large-scale visual output by projecting images or videos onto a screen 

or wall. Used in classrooms, movie theaters, business presentations, and 

conferences. Some modern projectors come with interactive touch 

functionality. 

e) Headphones and Earphones 

Provide personalized audio output without disturbing others. Used in music 

listening, gaming, video conferencing, and online learning. Noise-canceling 

headphones offer an enhanced experience by reducing background noise. 
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f) Braille Display 

Input and output devices are essential components of a computer system, 

facilitating smooth interaction between users and machines. These devices act 

as communication bridges, enabling users to send data, commands, and 

instructions while allowing computers to process and display results. The 

effectiveness of a computer system depends significantly on these devices, 

which are used across various industries, including business, education, 

healthcare, and entertainment. Input devices allow users to enter data into a 

system, while output devices present processed information in a usable format. 

Their combination ensures efficiency, accessibility, and improved user 

experience. Input devices are hardware components that allow users to interact 

with computers by feeding data for processing. The most commonly used input 

device is the keyboard, which enables users to type text, enter commands, and 

perform various functions through specific keys. Another widely used device is 

the mouse, which allows users to navigate, select, and interact with objects on 

a screen. More advanced versions, such as touchpads and trackballs, provide 

alternative input methods, particularly in laptops. In addition, touchscreens 

have become increasingly popular in smartphones, tablets, ATMs, and self-

service kiosks, eliminating the need for separate keyboards and mice. 

Apart from textual and navigational input, audio and visual input devices also 

play a crucial role in modern computing. Microphones allow users to input 

sound, making them useful for video conferencing, voice recognition, and 

digital communication. Similarly, scanners convert physical documents and 

images into digital formats, aiding in document management and digital record-

keeping. Another essential input device is the joystick or game controller, which 

is widely used in gaming and simulation applications. These devices provide 

users with a more immersive experience, allowing precise control over digital 

environments. Furthermore, biometric scanners, such as fingerprint and facial 

recognition systems, are becoming increasingly common in security and 

authentication processes. 
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Once the input is processed, the computer uses output devices to present the 

results in a meaningful way. The monitor is the most common output device, 

displaying text, images, videos, and interactive content. Modern monitors come 

in different types, such as LED, LCD, and OLED screens, with varying 

resolutions and refresh rates to enhance the user experience. For physical 

documentation, printers convert digital text and images into hard copies. There 

are several types of printers, including inkjet, laser, and 3D printers, each 

serving different purposes in homes, offices, and manufacturing industries. For 

audio output, speakers and headphones allow users to listen to music, 

communicate in virtual meetings, and experience immersive sound in gaming 

and multimedia applications. High-quality surround sound speakers and noise-

canceling headphones provide enhanced auditory experiences. In environments 

requiring large-scale presentations, projectors display enlarged images and 

videos onto screens, making them useful in educational institutions, business 

meetings, and entertainment settings. Accessibility is a crucial aspect of modern 

computing, ensuring that individuals with disabilities can effectively use 

technology. One of the most significant innovations in assistive technology is 

the Braille display, a specialized output device designed for visually impaired 

users.  

Short-Answer Questions: 

1. How does one computer serve in the primary function? 

2.  features of computer and their explanation 

3. What technology characterized the first generation of computers? 

4. What took the place of vacuum tubes in second generation of computers? 

5. What is the definition of integrated circuit (IC)? 

6. What is a microprocessor? 

7. What is the fastest computer? 

8. What computer is used for large scale enterprise data processing? 

9. What are Input devices? 

10. What makes up the two main parts of the CPU? 
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Long-Answer Questions: 

1. Discuss the five generations of computer technology, focusing on the 

development of the new technology in each generation and the role it 

played in the advancement of computer science. 

2. Characteristics of computers (speed, accuracy, automation, versatility, 

storage, connectivity, multitasking) and their usefulness of computers in 

modern society. 

3. What are the differences between supercomputers and mainframes? 

Provide some typical uses and applications of the systems along with 

their strengths and weaknesses as compared to each other. 

4. Explaining Embedded Computers in Give an example of Embedded 

Computer in Embedded computer in Intelligent applications. 

5. What is the functioning of the input unit in a computer system, and 

provide examples of different types of input devices with their uses? 

6. What the Arithmetic Logic Unit (ALU) and control unit (CU) do and 

how the Central Processing Unit (CPU) works. 

7. There is a lot of novelty in history that is difficult to understand, like why 

computers evolved from vacuum tubes to transistors to integrated 

circuits, then to microprocessors, and what all this evolution meant for 

people. 

8.  Discuss the differences between microcomputers, minicomputers and 

mainframes, and how their uses and applications have changed over the 

years. 

9. Explain the fifth generation of computers and their significance and 

discuss how AI will the computers of the future. 

10. Versatility of Computer: We should also talk about the amazing 

versatility of computer in this age. 
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MODULE 2 INTRODUCTION TO MS WORD 

Structure 

Unit4 Microsoft Word – Introduction 

Unit5 Working With Word Document 

 Working With Tables 

 Tools In Ms Word 

UNIT 4 MICROSOFT WORD – INTRODUCTION 

Microsoft Word is a word writing program that was made by Microsoft in 1983. 

It's the Word program that most people use. It lets you make documents, letters, 

reports, resumes, and other things that look professional, and it also lets you 

edit or change documents that you already have. The file that was made in 

Microsoft Word has the.docx ending. It comes with Microsoft Office, but you 

can also buy it on its own, and it works on both Windows and macOS. It's 2019 

since the last version of MS Word. This guide shows you how to open Ms. 

Word before you learn about its features. 

How to open MS Word? 

To open MS Word, do the next thing: 

First Step: In the search bar, type "Ms. Word.". 
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Step 2: Select Ms Word application. 

Step 3: Pick out a new file and press the "Create" button.  

 

Then you'll see a window like the one below, where you can write your text and 

change things about it, like the font type, style, boldness, italics, and so on. You 

can also add pictures, tables, and charts to your work. 
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Features of MS Word 

Let's talk about a type of MS Word features or parts now. With these features, 

you can do different things with your documents, like add, remove, style, 

change, or just look at the text.  

1. File 

When you click it, It shows choices that have to do with files, such as New (to 

make a new document), Open (to open an existing document), Save (to save a 

document), Save As (to save a document), History, Print, Share, Export, Info, 

and so on. 

 

2. Home 

As a general rule, MS Word's main tab is split into five groups: Clipboard, Font, 

Paragraph, Style, and Editing. You can pick the text's color, style, emphasis, 

bullet points, and size, among other things. It also holds the options to cut, copy, 

paste, and so on. You can do the following once you click on the "Home" tab: 
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3. Insert 

It is also the second ribbon or menu bar tab. That is a collection of things you 

would alternatively like to put into a Microsoft word. There are tables, word art, 

hyperlinks, symbols, charts, signature lines, dates and times, shapes, headers, 

footers, text boxes, other hyperlinks, boxes, equations, and more. The image 

below shows some of these choices: 

 

4. Draw 

The third tab is in the menu bar or ribbon. It's for drawing by hand in MS Word. 

It also comes with the following kinds of drawing pens: 
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5. Design 

It is the second button or tab [the fourth tab in the menu bar/ribbon]. The design 

tab has various instance designs which you can pick, which hits you with 

centered titles, staggered headers, For more information on things like left-

justified text, page fringe, stamp, page color, and more, see the picture below:  

 

6. Layout 

The fifth tab can be found in the menu bar or ribbon. That means you can 

arrange the pages of your Microsoft Word file in any way you like. As shown 

in the picture below, you can set margins, show line numbers, set paragraph 

indentation and lines, apply themes, change page layout, size, line breaks, and 

more:  

Fundamental 

Computer Skills 

MATS Centre for Distance and Online Education, MATS University



53 
 

 

7. References 

It is the sixth option in the menu bar or ribbon. The references tab allows you 

to enter references to a document, then generate a bibliography at the end of the 

text. The references are usually kept in a master list, from which references 

service subsequent documents. It provides features such as, Table of Contents, 

Footnotes, Citations & Bibliography, Captions, Index, Table of Authorities, the 

smart appearance, and many more. Once you click on References tab you will 

get below options: 

 

8. Mailings 

It is the seventh tab in the menu or ribbon. It is the tab in menu bar least used. 

This tab is where you would make labels, print them on envelopes, mail merge, 

etc. After Selecting Mailing, you will have the below options: 
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9. Review 

It is the 8th tab in the menu bar/ribbon. On the review tab we have, 

commenting, language, translation, spell check and word count tools The latter 

is useful for finding and modifying comments quickly. Once you click on a 

review tab, you will have the below options: 

 

10. View 

It is the 9th tab on the Menu bar or ribbon. View tab helps switch between 

single page or double page also controls the layout tools print layout, outline, 

web layout, task pane, toolbars, ruler, header and footer, footnotes, full-screen 

view, zoom etc are found here as shown in the below image: 
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WORKING WITH WORD DOCUMENT 

MS-Word or Microsoft Word is a Wonderful and very user-friendly and 

interactive word processing software with rich capabilities. Documents like 

letters, articles etc, can be created by the user using it. MS-Word provides a 

wide range of features that help make it operate so simple. 

Opening the Document 

Document opening is so simple and this is kind of the first action a user can 

perform to begin working with MS Word. It is clear that in order to create any 

document or to make changes to any document, We first need to access that 

document. So, here in thie article, we are going to learn how to open a 

document in MS Word. 

This we will teach you the complete process of a little opening a document 

with the help of sample images and the also necessary instruction: 

Method 1: Opening Default Document 

When everyday we opens MS-Word a blank page with a default name is 

opened (generally “Document1”). 

Step 1: Open MS-Word On your PC   

Step 2: The screen shown below is already visible with default new document 

blank page. 
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Method 2: Opening a document of your choice 

Different kinds of documents are created using MS-Word. Well, A scenario 

might arise where we have to open a document i.e. existed, and we need to edit 

that document. So, for this follow these steps: 

Step 1: Open MS-Word in your PC. Hence, the screen appear like below 

image: 
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Step 2: Now, above there is a tab called “File” (Shown in the image below). 

 

Step 3: Now, Click on the “File” tab and the file tab will open and looks like 

the below image. 

 

Step 4: Now, on the left-hand side of the page or screen there are many options. 

Select “Open” to open a document of your choice. 

 

Step 5: Now, open the document of your choice, by double-clicking on the file 

of your choice. 
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Step 6: Now, the opened document will look something like the below image. 

 

Step 7: You have successfully opened the document of your choice. 

Method 3: Opening a New document 

This is one such condition or situation when a user is in the process of working 

in MS-Word and needs a new document. So, lets explore how it can be done 

step by step: 

Step 1: Open MS-Word in your PC first. 

Step 2: When you open the document you will work. (like in the below image) 
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Step 3: Now, You want to open a fresh new document to work in. 

Step 4: Now, above there is a tab called “File“(Shown in the image below).  

 

Step 5: Now, Click on the “File” tab and the file tab will open and looks like 

the below image. 

 

Step 6: Now, on the left-hand side of the page or screen there are many options. 

Select “New” to open a fresh new document. 
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Step 7: Now, After clicking on “New“. Select a Template from “available 

Template” option. (marked in the image below)   

 

Step 8: After selecting a template (in this example blank is selected). Click on 

the “create” option, which is present on the right side of the screen. 
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Step 9: You have successfully created the new document or opened a new 

document.  

 

So, in all these ways we can open a document in MS-Word.  

WORKING WITH TABLES 

Microsoft Word or MS-WORD is a word processing software for computers 

that uses a graphical interface allowing users to enter text. It enables users to 

write and store documents very similarly to other word processing programs. 

MS-word itself is a very popular tool which can be found in different versions 

in the market. In this tutorial, we are going to study the tables in MS-Word. In 

MS Word, a table consists of systematic arrangement of text in rows and 

columns. You can align numbers in columns using these tables and they are 

used to perform operations on those numbers. You can use tables to create page 

layouts. A row is a set of tables or data banks that are organized horizontally 

in a table or spreadsheet. Columns:  The vertical series of cells in a chart, table, 

or spreadsheet. 

How to Create a Table? 

Tables in MS Word can be created in the following two ways: 
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1. Using the Grid 

2. Using Table Dialogue Box 

Using the Grid 

Following are the steps of creating a table using the Grid provided in MS Word: 

Step 1: Go to the Insert tab and click on the Table button. 

 

Step 2: In the dropdown menu, select the number of rows and columns from 

the Grid. 
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Using Table Dialogue Box 

Following are the steps of creating a table using Table Dialogue Box in MS 

Word: 

Step 1: Go to the Insert tab and click on the Table button.  

 

Step 2: Under the grid, you will see an Insert Table button. Click on it. 

 

Step 3: In the Insert Table Dialogue box, mention the number of rows and 

number of columns as per the requirement and click on OK button. 
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How to Modify a Table? 

Table can also be edit/modify to make it more creative. There are many 

operations that can be performed on the table such as changing the layout, 

splitting of cells, merging the cells, applying borders, etc. In the following you 

can find a few operations which one can perform on a table in MS Word. 

Changing Layout of a Table 

The following steps can easily assist you in changing the layout of a table: 

Step 1: Choose the table to change the layout of. Go to the design tab. 

 

Step 2: Click on the dropdown menu to get various different types of layouts 

for your table. 
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Step 3: Select any layout as per the need. 

 

Splitting the Cell 

Here are the following steps which will help you in the splitting of the cell. 

Step 1: Click on the cell which you want to split into multiple cells. Now head 

over to the Layout tab and hit the Split Cells button. 
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Step 2: In the dialogue box, mention the new dimensions as per the 

requirement.  

 

Step 3: Click on the Ok button. 
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Merging the Cells 

Steps for merging of different cells:  

Step 1: Highlight the cells which need to be merged in to a single cell. Then 

go to the layout tab, and you will see a Merge Cell button. 

 

Step 2: Now click on the Merge Cell button and the selected cells will be 

merged. 

 

Applying Borders and Styles on a Table 

Borders and styles can be used the same way you change the layout of a table. 

Here are the steps to do the same: 

Step 1: Select the table you created and be sure to inspect the design tab.
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Step 2: Select the style that you want to apply to your table. 

 

Converting Text to a Table 

You can convert existing text into a table in MS Word using the following 

steps: 

 Step 1: Select the text to be changed into the table Now move to Insert Tab 

Table button will be there. 
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Step 2: Select the Insert Table button and from the drop-down menu, select the 

Convert Text to Table button. 

 

Step 3: In the dialogue box, Specify the size of the needed table, and also other 

details which are needed.  
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Step 4: Click on the OK button and the selected text will be converted to a 

Table. 

 

Inserting Images in a Table 

Add image into table cell in MS Word: You can also insert image inside the 

table cells. Follow these steps to add an image in a table: 

Step 1: Choose the cell where you want to put the Image. Navigate to the 

Insert tab and click on the Pictures Button. 

 

Step 2: You can either choose a picture from your device or select one online. 

Step 3: Choose a picture from the browser window and click on the Insert 

button.
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Step 4: Selected Image will be added in the cell selected. 

 

Performing Calculations in a Table 

You can also do mathematics on the values contained in the table. To perform 

these operations Microsoft has different formulas. Word calculates by default 

the sum of the values that are located in the rows to the left or in the column 

that is above. Here are the steps that you need to follow: 

Step 1: Go to the cell where you want the result of the mathematical 

operations. 
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Step 2: Now go to the Layout tab and select the formula button.  

 

Step 3: Set the formula (the default operation is to take the sum of values on 

the left and above) in the dialogue box. 
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Step 4: After defining the formula, click on the OK button to apply the formula 

on the cells given in the formula. 

 

TOOLS IN MS WORD 

Format painter 

 

I love the format painter feature in all Microsoft Office programs. This feature 

is a quick shortcut to help you maintain the consistency of your fonts throughout 

when you are working with different fonts, sizes, and styles. 

Suppose you have paragraphs broken by headings and those headings are in 

bold and a larger font. Instead of highlighting each heading and figuring out 

how to get it to match the others, you instead highlight one of the previously 

formatted headings, click on the “format painter button,” and then highlight the 

text to match the previous heading. If you do use the format painter it will 

replicate the font, size and colour accordingly, taking it from the original 

selection. 
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Notably, it is useful for long documents in which fonts need to be switched 

multiple times. Format painter will also tab over lines to match your selection 

and help keep formatted lines straight. 

 

Styles 

 

Speaking of styles, the style section on the Home tab is always in your face, 

but do you know what it’s for? Styles are great for when you have a lot of 

formatting to do with more than one type of heading or bullet point. 

Every style box comes with a preset format that you can change to your color 

display of choice, preferred font or employer’s specifications. By clicking 

modify after right clicking on a style like Heading 1, you can preset your style. 

Then, each time you highlight text and click on the style box, you will alter the 

font to that style you set. 
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You may also format the text in your documents the way you like. Then click 

“Update (style name) to match selection.” Now, whenever you choose that 

style, it will be matched to the font you preset in your document. It should be 

beneficial in the making of guides some other extensive records with a few 

styles.  

Legacy forms 

 

There are a lot of tabs in Word; some are hidden and you probably didn’t even 

know about. The Developer tab is one you're going to need to build forms, but 

you have to add the tab to your screen. It’s not automatically there. 

To add it, go to “File.” Go to the “customize” ribbon for your main tabs. Find 

the “Developer” tab. Then, add it to your screen. Ensure it appears as the final 

tab at the top of your Word document. 

Inside it, you’ll see a little folder icon followed by a dropdown button. In this 

dropdown are more icons where you can insert fillable checkboxes, lines, radio 

buttons, etc. If you’re a blogger who likes to do fillable worksheets as 

giveaways, this may be a fantastic resource for you. 
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Restrict editing 

 

When it comes to sharing forms, charts or other word documents that you create 

then we are having a scenario where you don’t want anyone editing the 

document, especially the wording on that legal form or anything. What to use 

in the meantime: Word has a feature that prevents others from editing your 

document. 

In Developer Tab, there is a piece of paper with a lock on it. In my copy of 

Word, it’s Protect Document. In newer versions of Word, it’s called Restrict 

Editing. Here you can decide who can make changes to what parts of the 

document, if at all. These may go straight from simple password locking so it 

can be two clicks away from unlock and editing to full password protection 

where without the password only a lock icon will be available. 

If you do any kind of legal work or have had issues with people changing 

shared documents without first consulting you or getting you’re okay, this 

feature is going to come in very handy. 
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Find/replace tool 

 

As I’m writing a novel, I often feel the need to change names at various stages 

in the narrative. Manually going through the text is tedious, to notice where I 

have written a word or a name either, and a lot of oversight can happen. So, I 

use the Find and Replace buttons on the Home tab to find every place in the 

document where that word was used. Then I can tell Word to replace that name 

with the name that I have decided on. You find a word; you don’t have to find 

a word and replace it. Using the Find tool alone is useful when I need to locate 

a specific moment in the story to either edit or cross check spelling for 

consistency in a character’s name. It takes you to what you want faster than 

scrolling through long doc. 

Page breaks 
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The more structured documents those full of charts and tables often require 

formatting to ensure those elements don’t run off the page. That’s when you 

start using page breaks, which is a layout tool you can use to jump ahead to the 

next page without messing up your formatting with too much space or tab keys. 

You navigate to the Page Layout tab and scroll through the Page Setup section 

to find page breaks. Breaks can also be beneficial when you’re dealing with 

columns that want to break up your text. It’s purely cosmetic, but it’s a 

cosmetic tool that can make your work appear more professional. 

The show/hide tool 

 

Does Word ever feel like it’s doing its own thing? Does it seem like there was 

something invisible standing between it and doing what you want it to do? The 

Show/Hide tool will make all invisible paragraph marks, and that, and other 

symbols appear that will tell you what’s going on between the lines. 

These symbols will display any space, tab, and page break in your document 

that exists. It’s where all of those little, invisible markers that mess up your lines 

and spaces can be found. Just click the button under the Paragraph section of 

the Home tab once and the symbols will appear, and click again the symbols 

disappear. 
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The split view tool 

 

When you’re working off of two separate Word docs, it’s a dizzying flip flop 

back and forth. Word’s split screen tool will bring two documents up on one 

screen so that you can view them both at once. Such feature is located on the 

Window section of the View tab. Open both documents in Word. Then select 

the icon labelled Split Head to the two documents you need to compare, which 

will display one over the top of the other. Click the View Side by Side icon to 

better able to read the two. In Word, this is set automatically to Synchronous 

Scrolling. This is useful when the documents are two variations of the same 

document. However, if you don’t want the two documents to scroll uniformly, 

click on the Synchronous Scrolling icon so that the feature is grayed out. Then 

you’ll be able to scroll through each document individually. 

Adding watermarks 
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A very simple and easily available tool which gives a useful facility every time 

you need to secure a document. The Watermark icon is located under Page 

Layout. It has the effect of putting the phrase you choose in a shadow text over 

every page of your document. 

This is helpful when you want to share a snippet of your work (or a chart that 

you created) while preventing that work from being copied or stolen. 

Watermarks have popped up at work over the years, and it’s helpful to both 

know where it is when the need arises. 

Table of contents 

 

In its simplest form, a table of contents is easy to make. But there’s much more 

under the hood that you should set up and experiment with so that you’re ready 

to roll if you need to create one in a professional setting. You can also format 

table of contents to be only showing specific headings or styles. It may or may 

not include page numbers. But they are particularly fine at offering a short-haul 

route that can take you directly to a section or chapter inside a longer work. 
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A whole post could go into the details of how to use the TOC feature. 

Messaging at the meaning of what you are trying to get there. Master this 

feature to build a complex and structured table of contents. And remember to 

click on the Update Table icon every time you make any changes to your 

document so that the table remains accurate. 

Short Answer Questions: 

1. What is the purpose of the "Split Cells" feature in MS Word? 

2. Which tab do you need to access to merge cells in a table? 

3. What does the Format Painter tool do in MS Word? 

4. How do you convert existing text into a table in MS Word? 

5. Where can you find the option to add a watermark in MS Word? 

6. What is the purpose of the "Restrict Editing" feature in Word? 

7. Which tab do you use to access the Table of Contents feature in Word? 

8. What is the default formula used in the "Formula" tool for tables in MS 

Word? 

9. How do you access the "Developer" tab in MS Word? 

10. What does the "Find/Replace" tool do in MS Word? 

Long Answer Questions: 

1. Describe the steps to split a cell into multiple cells in MS Word and 

explain how to adjust the new dimensions. 

2. How do you merge cells in MS Word? Provide a detailed explanation of 

the process. 

3. Explain how you can apply borders and styles to a table in MS Word 

and the role of the "Design" tab in this process. 

4. How do you insert an image into a table in MS Word, and what steps 

should be followed to ensure the image is properly inserted? 

5. Describe the steps to perform calculations in a table using MS Word’s 

built-in formula feature. Provide examples of how this feature can be 

useful.
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6. What is the Format Painter tool in MS Word, and how does it help in 

maintaining uniform formatting across a document? Give examples of its 

practical use. 

7. Discuss the role of the "Styles" feature in MS Word. How can it help 

maintain consistent formatting, and how can you modify and apply styles 

to headings and text? 

8. How do you add fillable forms using the "Developer" tab in MS Word? 

Provide a step-by-step guide on how to use this feature effectively. 

9. Explain how the "Restrict Editing" feature in MS Word works. How can 

you protect specific parts of a document from being edited by others? 

10. Describe the functionality of the "Split View" tool in MS Word. How does 

this feature improve productivity when working with multiple documents?
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UNIT 5  INTRODUCTION TO MS POWERPOINT 

Structure 

 Ms Powerpoint 

 Concept Of Slide Shows 

 Getting Started With Powerpoint Animations 

MS POWERPOINT 

Information can be displayed using an electronic presentation application. This 

information is usually presented as a slide show — the data is displayed on a 

slide that may be viewed on a computer monitor or projected onto a screen using 

an LCD projector. A presentation might consist of multiple slides that are 

exhibited one after the other. The presentation tool in MS Office is MS 

PowerPoint. Microsoft PowerPoint is a popular presentation application, 

although there are alternatives such as Corel Presentations OpenOffice.org, 

Impress, etc.  

Three major components of a presentation program are:  

(i) An editor that allows text to be input and formatted  

(ii)a means for inserting visual pictures, audio, and video  

(iii) and a slide-show system to display the final content. 

How to open MS PowerPoint 

In Windows 8/above: 

Step 1: Press Windows + c to open the search bar 
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Step 2: Type PowerPoint & click on the MS Office version you are having in 

your system. MS Office window will pop up. 

In Windows 7 or below: 

Step 1: Go to the program section in the windows start menu. 

Step 2: Go to MS Office & click on it. A drop-down list is seen 

Step 3: Click on MS PowerPoint & MS PowerPoint window will pop up. 

Creating a Presentation 

Once your MS PowerPoint Window pops up, you can create & save the file by: 

Step 1: Click on the Microsoft button on the top left. 

 

Step 2: Click on new, a new Presentation window will pop up.
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Step 3: Click on Create & a new presentation will be created. 

Note: Shortcut for New: Ctrl +n 

Saving a Presentation 

Once you have created a presentation, it can be easily saved with the help of 

following steps: 

Step 1: Click on the Microsoft icon 

Step 2: Click on the Save button 

 

Step 3: A new Window for Save As will pop up.  
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Step 4: Select the drive (by clicking on it: Example: Local Drive (D)) in which 

you want to save the presentation. Then your drive will open up, select the 

folder in which you want to save the presentation (Example: img folder here) 

& then give the required name to your presentation (Example: MyPresentation 

here). Your presentation is created & saved with the provided name. 

Note: Shortcut for save: Ctrl + s 

Basic Elements of a PowerPoint Window/Slide 

You can see various bars in the presentation window. They are: 

(i) Title Bar: This shows the name/title given by you to the current 

presentation. If user do not save the presentation by any name, default name 

given by MS PowerPoint appears in this bar. 

(ii) Menu Bar: Contains menu items like insert, views, design, animations, etc. 

(iii) Office Button: MS Office button on the left-most top. 

(iv) Formatting Toolbar: Have tools like Bold, Italic, Underline, Font shape 

& size etc. to format your data. 
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(v) Zoom Slider: To zoom in or zoom out your presentation. 

(vi) Slide Sorter Pane: This allows us to choose which slides will be shown in 

which sequence during the slide show. 

(vii) Notes Pane: This allows us to type notes that we may require later when 

preparing for the presentation, but they will not be displayed during the slide 

show. 

(viii) View Buttons: Provides different views of your presentation like: normal, 

slide show & slide sorter. 

(ix) Slide Pane: This is where we type, format, and otherwise design the slide. 

CONCEPT OF SLIDE SHOWS 
 

After preparing the presentation, it’s time for the slide show. Steps for slide 

show are: 

Step 1. Click on the view Option on the top Menu Toolbar 

Step 2. Click on the slide show option. 
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Step 3. The slide show will start (Press Esc key (escape) to come out of slide 

show) 

Note: Shortcut for the slide show is: F5 

Sample Questions 

Question 1. How to print a Presentation through an attached printer? 

Answer: 

Step 1: Click on the Microsoft icon 

Step 2: Click On Print & a window for Print & Preview the document will pop 

up. 

 

Step 3: Click on Print. Then a window for Print will pop up. 
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Step 4: Select the printer by which you want to take out print of the document.  

Select the page range (Print of all or some or current page) & number of copies 

you want. 

Step 5: Click on OK. 

You will get print of your Presentation. 

Note: Shortcut for print is Ctrl + p. 

Question 2. What will you do for closing a Presentation? 

Answer: 

The procedure is as follows: 

1. Go to Office Button  

2. Click on close (last option in the list) 
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Question 3. Give shortcuts to create, print, close & save a presentation. 

Answer: 

1. Ctrl + N – Create a New presentation. 

2. Ctrl + S – Save a presentation. 

3. Alt + F4 – Close a presentation. 

4. Ctrl + P – Print a presentation. 

Question 4. What is MS PowerPoint? 

Answer: 

PowerPoint (PPT) is a powerful and simple-to-use presentation graphics 

software tool for creating professional-looking electronic slide shows. 

A PowerPoint presentation, or PPT, is a collection of slides that exhibit a 

graphical and visual interpretation of data in order to deliver information in a 

more creative and dynamic way. 

Question 5. In a slide, what kind of elements can be added? 

Answer: 

In a slide, we can add: 

-Graphs 

-Clip Art 

-Tables 

-Media Clips 

-Pictures 

-Charts 

-Videos etc. 
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GETTING STARTED WITH POWERPOINT 

ANIMATIONS 

Let's go over the many kinds of PowerPoint animations. Essentially, there are 

two main categories of PowerPoint animation effects:  

1. Transitions 

2. Animations 

One kind of PPT animation that occurs between slides is called a transition. To 

see every transition effect that is available to you, you can view the Transitions 

menu. When you want a discernible change between two slides, these are 

perfect. 

 

Transition options in PowerPoint. 

PPT animations on your slide are called animations. The Animations pane is 

where you can see your selections. When displaying your slide, these are 

frequently used as action effects. For instance, you can utilise an animation to 

draw attention to a certain portion of your presentation. 

 

Animation in PowerPoint effects and options 

Discover how and when to add animation to PowerPoint. Without further ado, 

let’s dive into these helpful PowerPoint animation tips and tricks.
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Download the Karbon — PowerPoint Presentation Template from Envato 

today. 

We'll use a paid Envato design for our tutorial. You may download the Karbon 

— PowerPoint Presentation Template here. There are dozens of stylish, 

contemporary slide layouts included. 

Note: The tips in this section were written using Windows 11 and Office 365. If 

you’ve got a different operating system or a different version of PowerPoint, 

your steps may be slightly different. 

15 Easy PowerPoint PPT Animation Tips, Effects, & Tricks for Beginners 

in 2025 

Let’s cover 15 of the best animation in PowerPoint templates. These 

PowerPoint slide animation techniques are a shortcut to mastery. 

Before we dive in, it helps to know: PowerPoint animations are controlled with 

the Animation Pane. 

1. Animation 101: Master Your Context 

The key lesson in effective animations is to understand when to use animation. 

An easy-to-remember guideline is the 80/20-rule. What 20% of your content in 

your presentation is the most important? That’s the content that might be 

worthwhile for you to add animation to. 
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For instance, the most thrilling aspect of your presentation can be the 

introduction of a new product line. It makes sense to draw attention to this in 

this situation by, for instance, including a Build In animation.  

By classifying their animations into various strength groups, PowerPoint assists 

you. Subtle, moderate, and exciting are some of these. 

 

Animations that are subtle, moderate, or exciting give your PowerPoint 

presentation a unique punch. 

You can employ the appropriate animation in the appropriate situation by using 

these animation strengths. For instance, draw attention to your main points, 

such as mentioning a rise in operating margins. 

In summary: Define what is your most important content in the 

presentation. When you choose an animation, make sure its strength matches 

the importance of each key point. 

2. Animation 101: Control Your Timing and Duration 

Once you’ve mastered where to add animation, next up is to understand when 

to animate. 

As described in the beginning of the tutorial, you can use transitions and 

animations. I’d recommend that you only choose one of either per slide that 

you’d like to add some animation to. Combining both often becomes a visual 

overload for your audience. 
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Once more, the slide's context is important. A transition might be perfect if you 

want to surprise the audience by showing them the entire slide. Using 

animations makes more sense if you want just a few items to appear at once. 

 

When you choose an animation in the Animation Pane, you can adjust its 

duration. 

Additionally important and significantly influencing how your animation is 

viewed is its duration. 

Have you ever seen a presentation with sluggish slide transitions? These 

striking visual impacts could initially be intriguing. But as you see them again, 

they gradually start to irritate you. It's tiresome. 

Tip: The general rule is to have faster animations. I typically choose a timing 

of 0.5 seconds. That’s slow enough to be noticeable, but fast enough to keep 

things moving. 

3. Animation 101: The Basics Work 

Even when working to make your animations subtle and effective, it can still 

be easy to overdo it. This is because PowerPoint has many types of animations. 

The choice can feel overwhelming. 
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A straightforward guideline might help your presentation feel lighter. 

Throughout your presentation, utilise the same animations.  

For the purpose of variety, it's tempting to include a wide variety of transitional 

animations. In actuality, though, the variety may detract from your main point. 

It makes your message less powerful. 

The animation kinds that I use the most are listed below: 

• Appear. To simply make an object appear in your presentation. 

• Fade. Probably my most used animation that feels a little slicker than 

Appear. 

• Zoom. A good way to quickly add emphasis on an element in your slide. 

 

Fade is a commonly used type of PowerPoint animation which always works 

well. 

Now that you’ve seen the basic concepts of animation, let’s dive into a few 

real-world examples of PowerPoint animations. We’ll explore how animations 

can enhance your presentation. 

4. Reorder Animations to Change Object Sequencing 

As you work, you’ll likely find yourself adding many animations in PowerPoint 

effects. And chances are, you may want to change up their order after you’re 

done. Easy! The Animation Pane lets you manage and reorder animations. 

After adding animations to your slide, click on the Animations tab. Then, select 

the Animation Pane. 
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All of the animations on your slide may be seen in the Animation Pane in an 

easy-to-read list format. Click and drag the animations up or down the list to 

the correct position to rearrange them. PowerPoint changes your animation 

sequence in a matter of seconds. 

 

To reorder and resequence your animations, use the Animation Pane. 

When attempting to modify the time of your animations, this is quite helpful. 

Additionally, it can be used to produce increasingly intricate animation 

sequences. 

You actually have complete control over your animation performance thanks to 

the pane. Simply altering the location of a particular slide animation effect 

allows you to change the tempo and flow of each slide. 

5. Enhance Your Message with Simple Animations 

Animations in PowerPoint help you call attention to changes and items of note 

on your slide. Consider the example of PowerPoint animations below. Notice 

how the result in Q3 was much higher. Imagine that a year ago, that quarter was 

actually the worst quarter. 

This is something you could mention verbally while giving the presentation. In 

this case, you would highlight the result of Q3’s improvement in a single year.
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A straightforward slide example showing the sales figures for the year. 

An example of an intriguing fact that can be highlighted with animation is this 

one. This is the strategy: 

Step 1. Add an Underline 

To accomplish this, choose "Q3: 6% increase" in PowerPoint and apply the 

following emphasis effect: Emphasise. A straightforward and understated 

method of emphasising text is to underline it. 

Step 2. Reset the Timing 

Open the Animation Pane. Select the animation you’ve just added. In 

the Timing options, make sure that it starts On Click. This way, you can run 

over the facts and figures while presenting your slide and then have the 

animation be displayed on the moment you want it. For example: 

1. First, run over the results of the year, quarter by quarter. 

2. Then click and start the underlining of Q3. 

3. Finally, you tell the story how Q3 used to be a losing quarter instead of your 

strongest quarter to date. 

Now you understand how pacing animations can be a much better delivery. 

Animation is PowerPoint is superior versus just dumping all content at once. 
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Key text is highlighted with the help of the Underline motion effect. 

6. Use Transitions Between Your Sections 

A PowerPoint presentation has a beginning, middle, and end, much like a tale. 

You might utilise a transitional animation to highlight those places in your 

presentation. 

You want to get straight to your final slide as an illustration of a PowerPoint 

animation scenario. We'll employ a transition animation to provide a little more 

impact and catch everyone's attention once more. 

There are lots of awesome options available in PowerPoint's Transitions menu: 

 

Explore the wide array of transition animations for PowerPoint.
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However, how can you choose which transition to employ? It's a good idea to 

consider the information on the slide you're switching to. For instance, the 

Fracture animation is a powerful metaphor if you're offering a solution to issues 

you've raised.  

 

The Fracture transition in action. 

Finally, consider the Dynamic Content category when utilising a transition 

animation. These are animations that animate between your current slides, 

which serve as their foundation. 

For instance, the animation will interact with the slide's elements. Consider 

them as PowerPoint animations that are "smart" enough to change according to 

your own material! If you want to do something more understated, this is 

perfect. 

7. Build Step-by-Step Animations into Your Slides 

If you’d like to make an explanatory slide, that often means that there are 

multiple elements of information that you’d like to present. The easiest way to 

do this is to reveal a numbered (or bullet) list: 
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A straightforward recipe slide with a few steps. 

We'll show each of the five steps individually rather than all five at once. 

Consider teaching a culinary class. By taking things one step at a time, you may 

help your audience stay focused on the next action rather than rushing ahead. 

Step 1. Apply the Fade Animation 

Launch the Animation Pane. Let's choose Fade as our entrance effect and 

choose the first step. Next, choose the second step and choose Fade once more. 

For the following steps, repeat these steps. 

Tip: Take care to choose each step separately rather than all of them at once. 

If not, they will all show up at once. 
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The order of the animations on your slide is visible in PowerPoint. 

Step 2. Set the Timing 

The Animation Pane is now available. The five animations you recently added 

are visible. You can reopen the Timing tab after clicking on the animation. 

Now, when cooking, you might want to start the animation After Previous and 

select a Delay rather than having it start on click. 

In this way, you're essentially creating a timer. Assume that each student has 

five minutes to grate the courgette in class. Choose the sauté zucchini 

animation, which is the third one. Select the After Previous time option and set 

a 300-second delay. 

 

The Animation Pane's Timing tab can be used creatively. 

This is what will occur: 

1. Grate Zucchini will appear. 

2. 5 minutes (300 seconds) will pass. 

3. The delayed animation kicks in and sauté zucchini will appear. 

This is an illustration of a PowerPoint animation that increases in speed as your 

presentation progresses. 
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8. Review Animations for Consistency 

When you’re finished adding animations for PowerPoint, your work isn’t quite 

finished. You should always review your presentation to be sure each animation 

works the way you intend it to. There’s nothing worse than being caught off-

guard in front of an audience. Yet, it’s easy to put an animation PowerPoint 

effect in the wrong place. The best way to review your animations is to go 

through the presentation after you’re done. Play it in Slide Show view, and only 

pay attention to your animations. 

Ask yourself these questions: 

• How does the pacing feel? 

• Are there sections in your presentation where there’s too much animation? Too 

little? 

• How does the timing feel? 

The last but crucial check step is to go over your presentation in its entirety. It 

assists you in making sure the effects of your PowerPoint animation are 

operating flawlessly. Additionally, it enables you to make any necessary 

modifications before an audience has problems. 

9. Use Animations to Present Your Data Dynamically 

By now, it should be easy to make a whole chart appear using an animation. 

But the true capacity of using animations with data is to pace how the chart is 

presented. We can do this by choosing the build order of our animation. 
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A slide presenting data in PowerPoint. 

Step 1. Add an Animation to a Chart 

Click on the chart you would like to animate. Next, add an animation. Again, 

your best bet here is to use simple animations in PowerPoint that won’t distract. 

 

Choose an animation for your PowerPoint chart using the drop-down menu. 

Step 2. Change the Animation Effects 

Select the drop-down menu for Effect Options. You can adjust the animation's 

sequence and the data that shows up using this option. The options available to 

you are as follows: 

• As One Object 

• By Series 

• By Category 

• By Element in Series 

• By Element in Category 
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To manage animation in PowerPoint charts and graphs, use the Effect Options 

menu. 

This gives the chart's data presentation a special degree of versatility. For 

instance, would you prefer to see all of the data at once or just one piece of data 

for a number of years? With the animation possibilities mentioned above, it is 

feasible. 

10. Pitch a New Product with Controlled Animation 

Making a new product pitch is one of the more interesting uses for animations. 

This enables you to capture the interest of your viewers! Animation provides 

the chance to showcase a product in a visually appealing manner. The best way 

to pitch a new product is to work in a ‘less is more‘ fashion. Apple is good at 

this for example, when you see their presentations. Usually, a simple entrance 

animation works perfectly. To make your animation a little bit more dramatic, 

play around with the timing. Instead of using the traditional 0.5 seconds, go for 

1 or even 2 seconds. This has a large impact on how the animation is seen. This 

is because slower animations are less commonly used in presentations. It’s a 

cool way to add some drama with animation in PowerPoint.
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11. Replicate Effects Easily With the Animation Painter 

One of PowerPoint's most useful tools for saving time is the Animation Painter. 

You can use it to duplicate and clone animations from one object to another. 

Selecting the item with the animation you wish to duplicate is the first step in 

using the Animation Painter. Next, select the Animation Painter button under 

the Animations menu. A paintbrush icon appears in place of the cursor. 

The object you wish to apply the motion to is then selected by clicking on it. 

The animation is immediately applied to the new item when you do this. 

 

To easily duplicate animation formats from one item to another, use 

PowerPoint's Animation Painter. 

You may produce dependable and captivating animations by using the 

Animation Painter. When you have a lot of items that require the same 

animation effects, it's incredibly helpful. 

Remember: Maintaining a consistent, stable appearance and feel is your aim. 

The Animation Painter guarantees that every animation is consistent with the 

others while saving you time. 
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12. Use a Transition to Declutter and Simplify 

When your layout is cluttered, using exit animations can help your slide look 

cleaner. If a straightforward slide comes next, this enables you to capture the 

audience's interest once more. 

Exit animations can be used to eliminate specific elements from the slide. Using 

a powerful transition between slides is an additional strategy. Using Morph is 

an intriguing shift. It contrasts the components of the two slides. It then 

determines the best transition method. It's more of a seamless transition than a 

powerful exit animation, although occasionally it works. 

 

You may simplify layouts and styles with the aid of these transitional 

PowerPoint animation effects. 

In this case, an animation like Honeycomb, Crush, or Curtains would be more 

appropriate. These animations tend to be visually heavy, so try to utilise them 

only once or twice in a presentation. 

13. Grab Attention with Formatting Text Animations 

You can highlight text in your presentation by using the formatting text 

animations. You can highlight text in a number of ways, including: 

• Font Color 

• Brush Color 

• Underline 

• Bold Reveal 

• Bold Flash 

Bold Flash is an excellent way of highlighting a line of text in a busy slide, for 

example. 
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Try these text-style effects for a fantastic PowerPoint animation example.  

It's simple to draw attention to a text passage using PowerPoint slide animation. 

Clarity and attention to your message are always valued by audiences. Slide 

animation aids in maintaining focus. 

Short Answer Questions (MS PowerPoint Basics): 

1. What is the primary function of MS PowerPoint?  

2. What is a "slide show" in PowerPoint?  

3. What is the shortcut key to start a slide show in PowerPoint?  

4. What is the purpose of the "Notes Pane" in PowerPoint?  

5. What is the function of the "Slide Sorter Pane"?  

6. What is the shortcut key to create a new presentation?  

7. What is the shortcut key to save a presentation?  

8. What is the shortcut key to print a presentation?  

9. What are transitions in PowerPoint?  

10. What are animations in PowerPoint?  

Long Answer Questions (MS PowerPoint Basics): 

1. Describe the steps to create a new PowerPoint presentation and save it.  

2. Explain the different views available in PowerPoint and their respective 

uses.  

3. How do you insert and format text in a PowerPoint slide?  

4. Explain the process of adding images and other media to a PowerPoint 

presentation.  

5. Describe the steps to set up and run a slide show in PowerPoint.  

6. How do you add and format a table in PowerPoint?  

7. Explain how to print a PowerPoint presentation, including different 

print options. 
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8. Describe the basic elements of the PowerPoint window.  

9. Explain the difference between transitions and animations in PowerPoint.  

10. How can you add and utilize notes in a PowerPoint presentation? 
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CHAPTER 4  INTRODUCTION TO MS EXCEL 

Structure 

Unit 6 Microsoft Excel – Introduction 

 Spreadsheet Basics 

 Formatting Worksheets 

 Types Of Charts 

Unit 7 Mathematical And Statistical Functions In Excel 

UNIT 6 MICROSOFT EXCEL – INTRODUCTION 

A popular tool for data analysis, visualisation, and automation is Microsoft 

Excel, a robust spreadsheet program created by Microsoft. Since its 1985 

inception, Microsoft Excel has developed into a vital tool for individuals, 

organisations, researchers, and educators handling enormous volumes of textual 

and numerical data. Fundamentally, Excel offers a worksheet a structured 

arrangement of rows and columns that enables users to effectively enter, 

arrange, modify, and analyse data. Unlike basic data entry applications, Excel 

is equipped with robust functionalities, including complex formulas, functions, 

pivot tables, and macros, making it indispensable in various domains. From 

financial modeling and accounting to statistical analysis and project 

management, Excel offers extensive capabilities that enhance productivity and 

decision-making. It is the perfect option for professionals working in teams 

because of its collaboration features, cloud-based storage (OneDrive), and 

smooth interface with other Microsoft Office products. Given the increasing 

reliance on data-driven insights, mastering MS Excel is no longer a skill 

exclusive to accountants or data analysts but a fundamental requirement for 

anyone dealing with information processing. 
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Key Features and Interface of MS Excel 

With its ribbon-based navigation and several tabs, including Home, Insert, 

Formulas, Data, Review, and View, Microsoft Excel's interface is made to make 

working with data easier for users. Groups of commands on each tab give users 

access to additional features, graphing choices, and formatting tools. A large 

area for data entry is created by the worksheet area's grid structure, which is 

made up of rows numbered consecutively (1, 2, 3, …, 1,048,576) and columns 

labelled with letters (A, B, C, …, Z, AA, AB, etc.). A cell is the intersection of 

a row and a column that contains text, numbers, dates, formulas, or functions. 

A notable feature of Excel is its extensive function library, categorized into 

mathematical, logical, statistical, financial, text, lookup, and reference 

functions, which allow users to automate calculations and derive insights with 

minimal manual effort. Additionally, conditional formatting helps visually 

differentiate data patterns, while features like data validation, filtering, and 

sorting enable efficient data management. Excel also supports dynamic data 

visualization through charts and graphs, making complex datasets easier to 

interpret. Moreover, recent versions of Excel include AI-powered data analysis 

tools and Power Query for advanced data transformation, further extending its 

capabilities. 
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Essential Functions, Formulas, and Data Handling Capabilities 

The capacity of Microsoft Excel to do intricate computations with both built-in 

functions and custom formulas is one of its distinguishing features. Excel’s 

formula system begins with an equal sign (=) followed by predefined functions 

or arithmetic operations. Some of the most frequently used functions include 

SUM() for total calculations, AVERAGE() for mean values, IF() for logical 

decision-making, VLOOKUP() and HLOOKUP() for data retrieval, and 

INDEX-MATCH for flexible searching. Additionally, TEXT functions such as 

CONCATENATE, LEFT, RIGHT, MID, and TRIM facilitate string 

manipulation, while DATE functions like TODAY(), NOW(), and DATEDIF() 

handle date-based computations. Excel’s data handling capabilities extend 

beyond simple calculations to data validation, filtering, sorting, and cleaning, 

making it a preferred tool for business intelligence and research. Users can 

import external data from databases, web sources, and other spreadsheets, 

enabling seamless integration for large-scale data analysis. Furthermore, the 

Pivot Table feature dynamically summarizes vast amounts of data, providing 

customized reports without modifying the original dataset. Automation has 

advanced to the point that Excel Macros and Visual Basic for Applications 

(VBA) enable users to write scripts that automate repetitive processes, greatly 

increasing productivity. These features empower professionals to transform raw 

data into meaningful insights, aiding in strategic planning, financial forecasting, 

and operational efficiency across industries. 
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Data Visualization and Advanced Analytical Tools 

MS Excel is excellent at data visualisation, allowing users to produce eye-

catching charts, graphs, and dashboards that improve data comprehension in 

addition to numerical computations. The Chart Tools feature allows the creation 

of various graphical representations, including bar charts, line graphs, pie 

charts, scatter plots, histograms, and waterfall charts, catering to different 

analytical needs. Excel’s Pivot Charts complement Pivot Tables by visually 

summarizing complex datasets, while sparklines provide miniature trendlines 

within a single cell. For deeper analytical insights, Power BI integration and 

Excel’s built-in forecasting tools help predict trends and perform regression 

analysis. The What-If Analysis tool, which includes Scenario Manager, Goal 

Seek, and Data Tables, assists in decision-making by evaluating different 

outcomes based on variable inputs. Additionally, Excel supports Solver, an 

advanced optimization tool used in linear programming, supply chain 

management, and resource allocation. Data analysts and financial professionals 

rely on Excel’s statistical tools such as ANOVA, regression, and correlation 

analysis to derive meaningful conclusions from data. As businesses 

increasingly leverage AI and machine learning, Excel has incorporated Power 

Query, Power Pivot, and AI-driven data types, making it an essential component 

of modern data analytics. These advanced tools ensure that Excel remains 

relevant in a rapidly evolving digital landscape, catering to both novice users 

and expert data analysts. 

Fundamental 

Computer Skills 

MATS Centre for Distance and Online Education, MATS University



113 
 

Applications, Future Trends, and Conclusion 

The adaptability of Microsoft Excel extends across a number of industries, 

including research, engineering, education, and healthcare as well as finance. 

In the corporate sector, Excel is widely used for financial modeling, budgeting, 

sales forecasting, and inventory management, helping organizations make data-

driven decisions. Educators and students utilize Excel for statistical research, 

grade tracking, and project management, while scientists and engineers rely on 

it for data analysis, simulations, and automation of calculations. In healthcare, 

Excel plays a crucial role in patient record management, medical data analysis, 

and epidemiological studies. As technology advances, Excel is evolving with 

cloud-based collaboration (Microsoft 365), AI-driven automation, and real-time 

data connectivity with online databases and APIs. With the rise of Big Data and 

AI, Excel is now being integrated with Python and R for more advanced 

analytics, enhancing its scope in data science and business intelligence. Future 

enhancements, including improved natural language processing (NLP) 

capabilities and interactive dashboards, will further cement Excel’s position as 

a leading analytical tool. Despite the emergence of alternative software like 

Google Sheets and Tableau, Excel remains indispensable due to its extensive 

functionalities, ease of use, and widespread adoption. Whether you are a 

student, professional, or researcher, mastering MS Excel equips you with a 

powerful tool that enhances productivity, decision-making, and problem-

solving in the digital age. 

One of the most popular Microsoft Office programs is MS Excel. It is a 

spreadsheet application for storing and analysing numerical data. Major 

competitive exams have computer awareness as a required subject, and they 

may also include questions from Microsoft Excel. Interested applicants can 

view the attached article for the Computer Knowledge syllabus in detail.  
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Basics of MS Excel 

What is MS Excel? 

Microsoft Excel is a spreadsheet application that allows users to enter data as 

tables. Data analysis on an Excel spreadsheet is simple. The illustration below 

depicts the appearance of an Excel spreadsheet: 

 

How to open MS Excel? 

To open MS Excel on your computer, follow the steps given below: 

Click on Start 

Then All Programs 

Next step is to click on MS Office 

Then finally, choose the MS-Excel option 

As an alternative, you can click the Start button and use the provided search 

option to type MS Excel. 
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What is a cell?  

Spreadsheets take the shape of tables with rows and columns. A cell is the 

rectangular rectangle that appears where rows and columns converge. Here is a 

picture of a cell: 

 

What is Cell Address? 

The term by which a cell can be addressed is known as its cell address. For 

instance, the cell address is G7 if row 7 is interested in column G.  

Features of MS Excel 

An Excel spreadsheet can be formatted and edited in a variety of ways. The 

different functions of Microsoft Excel are covered below.  

The MS Excel feature composition is displayed in the image below: 

 

• Home: Includes choices for cell insertion and deletion, formatting 

options and styles, alignment, font size, font styles, font colour, 

background colour, and editing options. 
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• Insert: Comprises options like table format and style, inserting images and 

figures, adding graphs, charts and sparklines, header and footer option, 

equation and symbols 

• Page Layout: Themes, orientation and page setup options are available 

under the page layout option 

• Formulas: Since tables with a large amount of data can be created in MS 

excel, under this feature, you can add formulas to your table and get quicker 

solutions  

• Data: Adding external data (from the web), filtering options and data tools 

are available under this category 

• Review: Proofreading can be done for an excel sheet (like spell check) in 

the review category and a reader can add comments in this part  

• View: Different views in which we want the spreadsheet to be displayed 

can be edited here. Options to zoom in and out and pane arrangement are 

available under this category 

For those willing to learn more about MS Excel, can refer to the video given 

below and understand every small aspect of this program in detail. 

Benefits of Using MS Excel 

MS Excel is preferred over traditional paper-based data management due to its 

efficiency and flexibility. Below are some of the significant benefits of using 

MS Excel: 

Easy To Store Data: Excel provides an unlimited capacity to store information 

in structured formats. Unlike traditional record-keeping methods, users can 

save extensive datasets without worrying about physical storage. Additionally, 

the filtering and sorting features make retrieving specific information quick and 

convenient. 

Easy To Recover Data: Retrieving handwritten data from stacks of files can be 

time-consuming and prone to errors. However, in Excel, users can locate and 

recover data effortlessly using search functions and backup features, ensuring 

minimal data loss. 
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Application of Mathematical Formulas: Excel simplifies complex 

calculations by offering built-in formulas and functions such as SUM, 

AVERAGE, VLOOKUP, and IF statements. This feature reduces manual effort 

and increases computational accuracy, making it ideal for financial modeling 

and data analysis. 

More Secure: Unlike physical records, Excel files can be encrypted with 

passwords, ensuring confidentiality and security. This prevents unauthorized 

access and reduces the chances of data theft or loss. 

Data at One Place: In the past, managing large amounts of data required 

multiple files and registers. Excel eliminates this hassle by allowing multiple 

worksheets within a single file, keeping all relevant information organized and 

easily accessible. 

Neater and Clearer Visibility of Information: Excel enhances data 

presentation through tables, conditional formatting, and graphs, making 

analysis straightforward. It enables users to highlight trends and patterns, 

improving decision-making processes. 

Key Features of MS Excel 

MS Excel is packed with various features that make it an essential tool for 

professionals and students alike. Understanding these features enhances 

productivity and efficiency when working with data. 

Worksheets and Workbooks: Excel consists of multiple worksheets within a 

single workbook. Each worksheet contains rows and columns that allow users 

to enter and manipulate data. 

Cells, Rows, and Columns: Cells, which are organised in rows (horizontally) 

and columns (vertically), are where data is kept. The row number and column 

letter (e.g., A1, B2) individually identify each cell. 

Formulas and Functions: Excel provides numerous mathematical and logical 

functions to automate calculations. Common functions include: 

SUM(): Adds values within a range 

AVERAGE(): Computes the mean of selected values 
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IF(): Implements conditional logic 

VLOOKUP() & HLOOKUP(): Searches for values in datasets 

Charts and Graphs: Excel makes it simpler to understand complicated 

statistics by enabling users to visualise data using bar charts, pie charts, line 

graphs, and more. 

Data Sorting and Filtering: Users can use filters to extract particular 

information based on predetermined criteria and organise data in either 

ascending or descending order. 

Pivot Tables: With the aid of pivot tables, users may effectively summarise big 

datasets and examine trends and patterns without changing the original data. 

Conditional Formatting: This function makes it simpler to see patterns, 

mistakes, or significant numbers by highlighting data according to particular 

criteria. 

Macros and Automation: Excel allows macros that use Visual Basic for 

Applications (VBA) to automate repetitive activities, increasing productivity 

and lowering human error. 

Collaboration and Sharing: Excel makes it simple to exchange data and work 

on projects with others by enabling real-time collaboration between several 

users. 

4.2 SPREADSHEET BASICS 

A computer program called a spreadsheet is made to add, show, analyse, 

arrange, and work with data that is grouped into rows and columns. It is the 

most widely used program for data display, analytics, accounting, etc. To put it 

another way, spreadsheets are grid-based, scalable files used for data 

organisation and computation. Spreadsheets are used by people worldwide to 

build tables for both personal and professional purposes. 
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Additionally, you can utilise the tool's features and formulae to assist you 

interpret your data. 

For example – Among other things, you can use a spreadsheet to track data and 

view sums, differences, multiplication, division, and fill dates automatically. 

Spreadsheet programs include LibreOffice, Apache Open Office, Google 

Sheets, Microsoft Excel, and others. The most widely used spreadsheet program 

among all of these is Microsoft Excel, which is compatible with Windows, 

macOS, Android, and other operating systems.  

Excel has many features, such as the ability to unprotect Excel sheets for data 

management and protection. Whether you're making a spreadsheet for project 

management or budgeting, you may start by using Excel spreadsheet templates 

to make your work easier. The Excel file extension.xlsx is the standard file 

format for Excel, guaranteeing compatibility and user-friendliness across all 

systems. 

What is an Excel Spreadsheet 

A workbook is a collection of spreadsheets. Each Excel document is referred to 

as a workbook. You must make a new workbook each time you begin a new 

Excel project. There are multiple ways to begin using an Excel workbook. You 

can use a pre-made template or start from scratch to create a new worksheet or 

access an existing one. A tabular spreadsheet with a matrix of rectangular cells 

arranged in rows and columns is called a single Excel worksheet. One page of 

a Microsoft Excel spreadsheet contains 17,179,869,184 cells total—1,048,576 

rows and 16,384 columns—where you can enter, edit, and manage your data. 
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Excel workbooks are composed of one or more worksheets that contain 

different kinds of connected data, much like a file or book is composed of one 

or more worksheets. Additionally, an infinite number of worksheets can be 

created and saved. The main goal is to gather all pertinent information in one 

location across numerous categories (worksheet) 

Features of Spreadsheet 

Spreadsheet applications are widely available on the market, as is well known. 

Thus, these apps offer the following fundamental functions: 

Rows and columns 

In a spreadsheet, rows and columns are two separate elements that combine to 

form a cell, range, or table. Typically, rows are the horizontal part of an Excel 

worksheet, with a maximum of 1048576 of them, while columns are the vertical 

part, with 256 possible. 

 

Row 3 is highlighted with the colour light green, while Column B is highlighted 

with the colour green. There are 1048576 rows in each column, and there are 

256 columns in each row. 

Cell Formatting 

In Microsoft Excel, cell formatting is the process of altering a worksheet's cell 

appearance to enhance readability, draw attention to key information, and create 

a more visually pleasing data display. Modifications to the cells' font, colour, 

borders, alignment, and number formats are examples of formatting. 
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Formulas 

Spreadsheet formulas automatically process data. It displays the results in the 

new section of the spreadsheet based on where the formula is written after 

processing the data from the designated area of the spreadsheet. To utilise 

predefined Excel formulas, all we need to do is type "=Formula 

Name(Arguments)" into Excel. Excel shows a drop-down menu of formulae 

that match the character sequence you enter when you type the initial few 

characters of any formula. Among the frequently utilised formulas are: 

• =SUM(Arg1: Arg2): It is used to find the sum of all the numeric data 

specified in the given range of numbers. 

• =COUNT(Arg1: Arg2):  It is used to count all the number of cells(it will 

count only number) specified in the given range of numbers. 

• =MAX(Arg1: Arg2): It is used to find the maximum number from the 

given range of numbers. 

• =MIN(Arg1: Arg2): It is used to find the minimum number from the given 

range of numbers. 

• =TODAY(): It is used to find today’s date. 

• =SQRT(Arg1): It is used to find the square root of the specified cell. 

For example, you can use the formula to find the average of the integers in 

column C from row 2 to row 7: 

= AVERAGE(D2:D7) 

D2:D6 defines the range of numbers that you wish to average. On the formula 

tab, the formula is next to the name field. 
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Since cell D9 has =AVERAGE(D2:D6) written in it, the average is (2 + 3 + 4 

+ 5 + 6 + 7)/6 = 27/6 = 4.5. In this way, you may rapidly build a workbook, 

work on it, peruse it, and save it. 

Pivot Table 

Microsoft Excel's Pivot Table function is an effective tool for reporting and data 

analysis. Through the creation of dynamic, interactive tables, it enables users to 

rapidly summarise, analyse, and explore massive volumes of data. Pivot tables 

make it simple to combine and reorganise data in order to obtain insights and 

display information in a relevant manner. 

Functions of SpreadSheet 

The function in spreadsheets creates output by applying a predetermined 

formula to the input. Or in other words, functions are created to perform 

complicated math problems in spreadsheets without using actual formulas. For 

example, if you want to find the total of the numeric data present in the column 

then use the SUM function instead of adding all the values present in the 

column.  

Text Manipulation 

The spreadsheet offers a variety of commands to work with the data it contains. 
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Pivot Tables: It is the spreadsheet function that is most frequently utilised. 

Users can utilise the toolbar to sort, group, total, and organise data using this 

table. Put another way, a lot of data is summarised using pivot tables. Several 

rows and columns are created from tonnes of data. 

Uses of Spreadsheets 

Spreadsheets can be used in countless ways. Usually, it is used to anything that 

has numbers in it. Spreadsheets are frequently used for: 

• Finance: Financial data, such as checking account details, taxes, 

transactions, bills, budgets, etc., are all stored in spreadsheets. 

• Forms: A spreadsheet is used to generate form templates for timesheets, 

surveys, performance reviews, and other forms. 

• School and colleges: Spreadsheets are most frequently used in 

educational institutions to manage student data, including grades and 

attendance. 

• Lists: Lists such as grocery lists, to-do lists, contact information, etc., can 

also be made using spreadsheets. 

• Hotels: Additionally, hotels employ spreadsheets to maintain customer 

data, including personal information, room numbers, check-in and check-

out dates, and more. 

Components of Spreadsheets 

The basic components of spreadsheets are: 

1. Title Bar: 

The spreadsheet and application names are shown in the title bar.  

2. Toolbar: 

It shows every action or option in Excel that can be used.   

3. Name Box: 

It shows the current or active cell's address. 
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4. Formula Bar: 

It is employed to show the information that we have entered in the active cell. 

Additionally, formulas are applied to the spreadsheet's data using this bar.  

5. Column Headings: 

Every Excel spreadsheet contains 256 columns and each column present in the 

spreadsheet is named by letters or a combination of letters.  

6. Row Headings: 

There are 65,536 rows in every Excel spreadsheet, and each row has a number 

assigned to it. 

7. Cell: 

In a spreadsheet, each cell contains a numeric value, functions, equations, and 

more. Another way to put it is that a cell is the intersection of rows and columns. 

Each cell has a unique name or address based on its rows and columns, and the 

first cell is referred to as an active cell when the cursor is on it. 

8. Cell referring: 

A cell reference, sometimes referred to as a cell address, is a method of 

characterising a worksheet cell that comprises a row number and a column 

letter. Cell references (in Excel formulae) allow us to refer to any cell on the 

worksheet. The cell in column A and row 1 is designated as A1, as can be seen 

in the image above. Such notations can be used to copy the value of one cell to 

another (using = A1) or in any formula. 

9. Navigation buttons: 

The first, previous, next, and last navigation buttons are found in a spreadsheet. 

You can switch between worksheets by using these buttons.  

10. Sheet tabs: 

A workbook is, as we all know, a compilation of worksheets. All of the 

worksheets in the workbook are included on this tab; by default, there are three, 

but you can add more based on your needs. 
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How to Create a New Spreadsheet or Workbook 

To create a new spreadsheet follows the following steps: 

Step 1: Click on the top-left, Microsoft Office button and a drop-down menu 

appear. 

Step 2: Now select New from the menu. 

 

Step 3: A New Workbook dialogue box will show up after choosing the New 

option. Click on the blank Document under the Create tab. 

Introduction to 

MS Excel 

MATS Centre for Distance and Online Education, MATS University



126 
 

 

Your screen displays a freshly generated blank worksheet.  

Note: A new Workbook is created for you when you launch Microsoft Excel on 

your computer. 

How to Save the Workbook  

The following procedures can be used to save a workbook in Excel: 

Step 1: A drop-down menu appears when we click the Microsoft Office button 

in the upper-left corner: 
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Step 2: Save or save now Choose one of the options to save the workbook. 

• Save As: to give the spreadsheet a name before saving it in a certain 

location. If you want to save the file for the first time or with a different 

name, choose Save As. 

• Save: Choose Save or, if the file has already been named, press Ctrl + S to 

save your work. 

So this is how you can save a workbook in Excel. 

Inserting text in Excel Spreadsheet 

Each rectangular box in a row or column of Excel is called a cell. Excel has 

multiple rows and columns. Therefore, on a worksheet or spreadsheet, a cell 

address can be found by combining a row number with a column letter. These 

addresses (in Excel formulas) allow us to refer to any cell in the worksheet. 

When you click on the cell, the address is displayed in the name box in the 

upper left (below the Home tab). 

 

To insert the data into the cell follow the following steps: 

Step 1: Go to a cell and click on it 

Step 2: By typing something on the keyboard, you can insert your data (In that 

selected cell). 
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Whatever text you type displays in the formula bar as well (for that cell). 

How to Edit/ Delete Cell Contents in the Excel Spreadsheet 

To delete cell content follow the following steps: 

Step 1: To alter or delete the text in a cell, first select it.  

Step 2: To remove or edit text, use the keyboard's Backspace key. 

Alternatively, to remove a cell's whole contents, press the Delete key. The 

formula bar can also be used to alter and remove text. Just move the pointer to 

the formula bar after selecting the cell. 

4.3 FORMATTING WORKSHEETS 

Making several charts for a given data collection is one of Excel's primary 

functions. We can alter these charts in a variety of ways using Excel to make 

them more informative. 

Using the appropriate example below, we will examine the most popular 

"Formatting" done on charts in this article. 

Example: Think about a batsman's performance during a Twenty20 match. The 

data set includes the runs that the batsman has scored in different games.
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We will now use the table above to insert a bar chart. To add a bar chart: 

Select dataset -> Click on Insert -> Chart Sets Pop Down -> 2-D column 

The key steps to format anything on the chart is: 

• Select the part of the chart which needs to be formatted. 

• Right-click on it and select “Format”. The format window will open. 

1. Formatting the Chart Title: 

Select the Title -> Right Click on it -> Format Chart Title 
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You can add borders around the title, alter the font colour, and make other 

changes in the Format Chart Title window. Another way to change the title is 

to just pick a new name and type it again. 

 

2. Formatting Axis Titles:  

You can add the axis title by using the “+” button in the top right corner of the 

chart. 

 

Select the X-axis and Y-axis and rename them. By right-clicking on the axis 

title and choosing "Format Axis Title," you may change how it looks”.
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3. Formatting Data labels:  

The "+" button in the upper right part of the chart lets you add Data Labels. 

 

You can now alter the font's colour, size, alignment, and many other settings by 

opening the Format Data Labels Window. 
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4. Formatting Data Series:  

By selecting the bar charts and then launching the "Format Data Series" 

window, you can alter their colour. By default, all of the data sets bars will be 

chosen when you left-click on any of the bars once. Left-click twice on the bar 

that needs formatting if you only want to pick one of these bars. 
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5. Formatting Axis:  

This is the most important formatting that we use to change the size of the axes 

to fit our needs. 
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When bound is used, it gives both the highest and lowest values that can be used 

to track. These lines on the axis are set by the major unit. 

6. Formatting Chart Style: 

 We have access to dynamic chart styles in Excel. Click on the "Paint brush 

icon" in the top right corner of the chart to pick the style you want. 
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7. Formatting Chart Type:  

Along with bar charts, Excel gives us a lot of other charts as well. To change 

the kind of chart:  

To change this, right-click on the chart and choose "Change." Choose a 

different type of chart.  

 

Choose the preferred chart type from the list of possibilities in the Chart Type 

window, as seen below: 
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8. Formatting Plot Area:  

Additionally, you can give your chart a backdrop colour. Click the "Format Plot 

Area" option. 

 

These formatting techniques are among the most commonly used for Excel 

charts. We can readily investigate Excel's dynamic chart formatting choices 

with a little self-research. 

4.4 TYPES OF CHARTS 

Microsoft Corporation offers Excel, a crucial piece of software. This program 

is a part of Office 365, one of the most popular software suites. Word, 

PowerPoint, and other programs are included in this software bundle. Since they 

are mostly used for office purposes, they are known as Office 365. However, a 

lot has changed in the globe since then. The world is aware of the benefits of 

employing digital tools since the Corona Pandemic. That was the same with 

Office 365. Excel software is also given some weight by users as a component 

of the software suite. They serve more than just official functions. However, 

they can also be employed in educational settings. Excel is a piece of software 

that can effectively store data. Thus, this software makes it easier to search for 

the data. 
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Excel has yet another fantastic function. From the given data, it may be used to 

create the charts. The charts are useful for examining any data expansion. 

Extracting some analysis from thousands of data points is a challenging 

undertaking. However, it will be simple to analyse those data if they are 

transformed into charts. The same can be done with an Excel sheet. No matter 

how much data there is in the Excel sheet, charts can still be created. There are 

two methods available for creating the charts. In one instance, users must do 

tasks independently. However, in order to generate those items, users must build 

a specific function. 

Creation of Charts in Excel using Worksheet Data 

Worksheet data is required for this approach. This is a straightforward 

technique for turning the provided data into charts. The manual way is this. This 

indicates that no code is used or automation integrated. The user must perform 

all of the actions. Even when the user performs it, it is still far simpler than other 

procedures. Since everyone can complete this technique without any problems 

or prior expertise. 

Step 1: In order to create the charts, users must first have a set of data. All of 

them must be entered into the Excel worksheet. They must follow this easy 

procedure. Users then have to decide which region they want to extract the chart 

from. There may be some data in the spreadsheet that should not be included in 

the graphic. Users must therefore choose which data should be included in the 

display. 
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Step 2: Users must now concurrently press Alt and F1. Consequently, users 

will be able to view the data in the form of a chart quite quickly. The chart can 

now be dragged in any direction by users. They can use it for other apps as well. 

The data analysis will be aided by this chart. This procedure is easy. 

 

So, we were able to use worksheet data to make a chart in Excel. 

Creation of Charts in Excel using VBA Code 

One unique kind of programming language is VBA code. However, unlike 

Python, Java, and others, they are not regarded as conceptual programming 

languages. This is the basic programming language included in Office 365 

software. This implies that programs like Word, Excel, and others can 

comprehend those. This programming language is readable by humans. 

Additionally, this aids in automating some Excel file functions. Additionally, 

this will aid in the creation of charts. 

Step 1: In order to utilise the VBA code to create the charts, users must also 

have some data. Here, a collection of data is assigned for the demonstration. 
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Step 2: The Developer Tab must be accessed by users. Users will find 

additional settings in this tab. Design Mode is going to be one of those 

alternatives. Clicking on that will launch the VBA editor for users. 

Note: Users may not see the Developer tab if they are using an outdated version 

of Excel. Users must press Alt+F11 at the same time in those situations. This 

will make it easier to edit using the same VBA window. Therefore, users 

shouldn't be concerned. Even the Office 2007 Edition may be used by users. 

However, this procedure will function in all editions. 

 

Step 3: Users now have to write some code. This code may appear to be as 

challenging as it is. However, a step-by-step analysis of this code will make the 

technique easier to understand. Let's attempt to identify the procedure one step 

at a time. 

1. Users must first select a topic. Programmers that write programs in the 

C programming language must follow the same procedure. In the C 

computer language, the main () function was the first thing that 

programmers wrote. The "Sub" will behave similarly in this situation. 

Access modifiers must be declared by users using the Java programming 

language. Additionally, users must give it a name. 

2. To perform additional actions, users must now declare a variable. Here, 

the keyword "Dim" is used to declare the variable. In order to create the 

chart, users must now supply a variable name and connect that variable. 

3. In order to create charts, users must now add the variable using the "Set" 

keyword. This line aids in utilising the declared variable to create a 

chart. 

Introduction to 

MS Excel 

MATS Centre for Distance and Online Education, MATS University



140 
 

4. Users must now supply the variable with data. Therefore, users must use the 

"SetSourceData" keyword to supply the data. Additionally, users must 

supply the name of the sheet and the range of data that will be used to create 

the chart. The "Sheet" name must be entered by users there. This is not the 

worksheet; it's the plain sheet. 

5. The procedure is now finished. It's time to wrap things up. There, users must 

utilise the "End" keyword. When utilising the ending brace in the C 

programming language, this is the identical procedure that any programmer 

must follow. 

VBA Code: 

Private Sub Comm 

Dim my_chart As Chart 

Set my_chart = Charts.Add 

my_chart.SetSourceData Sheets(“Sheet1”).Range(“A2:B14”) 

End Sub 

 

Step 4: Users will now see a play button on the top side of the VBA Editor once 

the process is finished. To create the charts from the written code, users must 

click on that button. 
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Step 5: The chart is currently visible to the users there. This chart can be used 

with any other software. Users can also drag to any other location. 

 

Hence, we have successfully created a chart in Excel using VBA Code. 

Excel is an effective tool for handling vast amounts of data. The purpose of this 

tool is to analyse data quickly. A set of data can be converted into a different 

format using Excel software. For this reason, the data provided there is used to 

create charts using this software. We have shown in this article how to create 

charts using the data from the spreadsheet. Additionally, we covered how to use 

VBA code and create charts using a given set of data. Here, the VBA code's 

methodical implementation approach is also covered. 
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UNIT 7 MATHEMATICAL AND STATISTICAL 

FUNCTIONS IN EXCEL 

Let's first examine the definition of statistics and its purpose before moving on 

to the statistical function in Excel. Therefore, one area of science that can assign 

a property to a sample is statistics. Data collection, organisation, analysis, and 

presentation are its main concerns. Karl Pearson, a renowned mathematician 

and the founder of contemporary statistics, once said, "statistics is the grammar 

of science.  

Every industry, including business, marketing, governance, engineering, and 

health, among others, used statistics. In summary, statistics is a quantitative 

instrument that helps us better comprehend the world.  For instance, before 

enacting any policies, the government researches the country's demographics, 

which can only be done with the use of statistics. As an additional illustration, 

it is crucial to comprehend your target audience while creating a film or 

advertising campaign, and statistics are a useful tool in this regard as well. 

Ways to approach statistical function in Excel: 

A variety of statistical functions are available in Excel, ranging from the simple 

median mode and mean to more intricate statistical distributions and probability 

tests. To comprehend statistical functions, we will separate them into two 

categories: 

1. Basic statistical Function 

2. Intermediate Statistical Function. 

Statistical Function in Excel 

Excel is the best tool to apply statistical functions. As discussed above we first 

discuss the basic statistical function, and then we will study intermediate 

statistical function. Throughout the article, we will take data and by using it we 

will understand the statistical function. 

So, let’s take random data of a book store that sells textbooks for classes 11th 

and 12th.  
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Example of statistical function. 

Basic statistical Function 

These are a few of the most popular and practical features. These consist of the 

following functions: COUNT, COUNTA, COUNTBLANK, and COUNTIFS. 

One by one, let's talk about: 

1. COUNT function 

To determine how many cells contain a certain number, utilise the COUNT 

function. One thing to always keep in mind is that it will simply count the 

number.  

Formula for COUNT function = COUNT(value1, [value2], …) 

 

Example of statistical function. 

Thus, there are 7 textbooks that have a discount out of 9 books. 
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2. COUNTA function 

This function will count everything, including the amount of cells with 

numbers, error values, and blank text, among other types of information. 

Formula for COUNTA function = COUNTA(value1, [value2], …) 

 

Example of statistical function. 

So, there are a total of 9 subjects that being sold in the store 

3. COUNTBLANK function 

COUNTBLANK function, as the term, suggest it will only count blank or 

empty cells.  

Formula for COUNTBlANK function = COUNTBLANK(range) 

 

Example of statistical function. 

There are 2 subjects that don’t have any discount.
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4. COUNTIFS function 

The most frequently used Excel function is COUNTIFS. The function counts 

the cell that satisfies a condition after operating on one or more conditions 

within a specified range. 

Formula for COUNTIFS function = COUNTIFS (range1, criteria1, [range2], 

[criteria2], ...) 

Intermediate Statistical Function 

Let's talk about a few Excel intermediate statistical functions. The analyst uses 

these functions more frequently. Functionalities such as the AVERAGE, 

MEDIAN, MODE, STANDARD DEVIATION, VARIANCE, QUARTILES, 

and CORRELATION functions are among them. 

1. AVERAGE value1, [value2], …) 

One of the most used intermediate functions is the AVERAGE function. The 

arithmetic mean or average of the cell within a specified range will be returned 

by the function. 

Formula for AVERAGE function = AVERAGE(number1, [number2], …) 

 

Example of statistical function. 

So the average total revenue is  Rs.144326.6667 

2. AVERAGEIF function 

The arithmetic mean or average of the cell within a certain range that satisfies 

the specified conditions will be returned by the function. 
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Formula for AVERAGEIF function = AVERAGEIF(range, criteria,  

[average_range]) 

3. MEDIAN function 

The data's central value will be returned by the MEDIAN function. It shares 

syntax with the AVERAGE function. 

Formula for MEDIAN function = MEDIAN (number1, [number2], …) 

 

Example of statistical function. 

Thus, the median quantity sold is 300. 

4. MODE function 

 The MODE function will return the most frequent value of the cell in a given 

range. 

 Formula for MODE function = MODE.SNGL(number1,[number2],…) 
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Example of statistical function. 

Thus, the most frequent or repetitive cost is  Rs. 250. 

5. STANDARD DEVIATION 

We may ascertain how much the observed value differed or diverged from the 

average with the use of this function. One of Excel's helpful features is this one. 

Formula for STANDARD DEVIATION function = 

STDEV.P(number1,[number2],…) 

 

Example of statistical function. 

Thus, Standard Deviation of total revenue =296917.8172 

6. VARIANCE function 

We must first define variance in order to comprehend the VARIANCE function. 

In essence, variance will establish how varied your data set is.  There is more 

volatility the more widely distributed the data.  

Formula for VARIANCE function = VAR(number1, [number2], …) 
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Example of statistical function. 

So, the variance of Revenue= 97955766832 

7. QUARTILES function 

Similar to how the median splits the data into two equal parts, the quantile splits 

the data into four parts. Thus, the dataset's quartiles are returned via the Excel 

QUARTILES function. The first quartile, second quartile, third quartile, 

maximum, and minimum values can all be returned. Let's examine the syntax: 

Formula for QUARTILES function = QUARTILE (array, quart) 

  

 

Example of statistical function. 

So, the first quartile = 14137.5 

8. CORRELATION function  

The correlation function, which is mostly employed by analysts to examine 

data, aids in determining the link between two variables. The correlation 

coefficient's range is between -1 to +1. 

Formula for  CORRELATION function = CORREL(array1, array2) 
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Example of statistical function. 

Therefore, 0.802428894 is the correlation coefficient between the store's 

revenue and discount. We can deduce that the discount has a positive 

relationship with revenue because it is a positive quantity. 

9. MAX function  

A given collection of data or array's biggest numerical value will be returned 

by the MAX function. 

Formula for  MAX function = MAX (number1, [number2], ...) 

 

There can be a maximum of 620 Physics textbooks. 

10. MIN function 

The smallest number in a given piece of data or array will be returned by the 

MIN function. 

Formula for MIN function = MIN (number1, [number2], ...) 
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The minimum number of the book available in the store =150(Sociology) 

11. LARGE function 

The only distinction between the LARGE and MAX functions is that the former 

returns the nth largest number in an array or set of data. 

Formula for  LARGE function = LARGE (array, k) 

Let’s find the most expensive textbook using a large function, where k = 1 

 

Example of statistical function. 

The most expensive textbook is Rs. 420. 

12. SMALL function 

The only distinction between the SMALL and MIN functions is that the former 

returns the nth smallest value in an array or set of data. 

Formula for SMALL function = SMALL (array, k) 

Similarly, using the SMALL function we can find the second least expensive 

book.
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Example of statistical function. 

Thus, Rs. 120 is the least cost price. 

So these are some statistical functions of Excel. We have learned some of the 

most simple functions like COUNT functions to complex ones like the 

CORRELATION function. So far we learn, we understand how much these 

functions are useful for analyzing any data. You can explore more functions 

and learn more things of your own. 

SHORT QUESTIONS 

1. What is MS Excel, and what is it used for? 

2. What is the default file extension for an Excel workbook? 

3. How are rows and columns labeled in Excel? 

4. What is a cell in MS Excel? 

5. How do you enter a formula in an Excel cell? 

6. What symbol is used to start a formula in Excel? 

7. What is the purpose of the AutoSum function? 

8. How can you merge multiple cells in Excel? 

9. What is the difference between a worksheet and a workbook? 

10. How can you insert a new worksheet in an Excel workbook? 

LONG ANSWER QUESTION 

1. Explain the key features of MS Excel and how it is used in data 

management and analysis. 
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2. Describe the components of an Excel worksheet, including rows, columns, 

cells, and ranges. How do they interact with each other? 

3. What are the different types of data that can be entered into an Excel cell? 

Provide examples of each. 

4. Explain the process of creating and applying formulas in Excel. Provide 

examples of commonly used formulas. 

5. What are functions in MS Excel? Describe five important functions with 

their syntax and usage. 

6. How does MS Excel help in data visualization? Explain different types of 

charts available in Excel and their applications. 

7. What is cell referencing in Excel? Explain the difference between relative, 

absolute, and mixed cell references with examples. 

8. What are the different ways to format cells in MS Excel? Discuss the 

importance of formatting in data representation. 

9. Explain the importance of sorting and filtering data in MS Excel. How do 

these features help in data analysis? 

10. Discuss the role of PivotTables in Excel. How do they help in summarizing 

and analyzing large sets of data?  
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